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Notices
This information was developed for products and services offered in the U.S.A. IBM may not 
offer the products, services, or features discussed in this document in other countries. Consult 
your local IBM representative for information on the products and services currently available 
in your area. Any reference to an IBM product, program, or service is not intended to state or 
imply that only that IBM product, program, or service may be used. Any functionally 
equivalent product, program, or service that does not infringe any IBM intellectual property 
right may be used instead. However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this 
document. The furnishing of this document does not grant you any license to these patents. You 
can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual 
Property Department in your country or send inquiries, in writing, to: 

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where 
such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES 
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties 
in certain transactions, therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new editions 
of the publication. IBM may make improvements and/or changes in the product(s) and/or the 
program(s) described in this publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and 
do not in any manner serve as an endorsement of those Web sites. The materials at those Web 
sites are not part of the materials for this IBM product and use of those Web sites is at your own 
risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate 
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) 
the exchange of information between independently created programs and other programs 
(including this one) and (ii) the mutual use of the information which has been exchanged, 
should contact:



IBM Corporation
Department BCFB
20 Maguire Road
Lexington, MA 02421
U.S.A. 

Such information may be available, subject to appropriate terms and conditions, including in 
some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are 
provided by IBM under terms of the IBM Customer Agreement, IBM International Program 
License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary significantly. Some 
measurements may have been made on development-level systems and there is no guarantee 
that these measurements will be the same on generally available systems. Furthermore, some 
measurement may have been estimated through extrapolation. Actual results may vary. Users 
of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, 
their published announcements or other publicly available sources. IBM has not tested those 
products and cannot confirm the accuracy of performance, compatibility or any other claims 
related to non-IBM products. Questions on the capabilities of non-IBM products should be 
addressed to the suppliers of those products.

Additional legal notices are described in the legal_information.html file that is included in your 
Rational software installation.
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Preface
Rational ClearQuest is a highly flexible defect and change tracking system that 
captures and tracks all types of change, for any type of project.

About This Manual

This guide is intended for the ClearQuest administrator. It explains how to install 
ClearQuest client, vendor databases, and related tools.

Before you install ClearQuest or ClearQuest MultiSite, we recommend that you read 
the following documents:

■ Release Notes provide the latest release information. The HTML files are available: 

❑ On the product CD at doc/ClearQuest/cq_relnotes.htm 

❑ In the network release area at rational_dir/arch/clearquest/doc/cq_readme.html 

■ Introduction provides an overview of ClearQuest components and how to use 
them.

■ Administrator’s Guide for Rational ClearQuest explains how to customize 
ClearQuest.

■ Administrator’s Guide for Rational ClearQuest MultiSite explains how to create and 
administer database replicas.
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ClearQuest Roadmap

More Information
Online documentation

Help files

Administration

Project 
Management

Orientation

Database
Design

Installation Guide (Rational Desktop Products)

Installation Guide (Rational Server Products)

Installation Guide (UNIX)

Administrator's Guide (Rational ClearQuest)

Administrator's Guide (Rational ClearQuest MultiSite)

Upgrade Guide (Rational Suite)

Using Project Tracker
(Windows platforms;

see online
documentation)

Introduction

Release Notes
(See online documentation)

Designer tutorials
(See online documentation)

Administrator's Guide
(Rational ClearQuest)

API Reference
(See online 

documentation)
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ClearQuest Integrations with Other Rational Products

Typographical Conventions

This manual uses the following typographical conventions:

■ ccase-home-dir represents the directory into which the ClearCase Product Family 
has been installed. By default, this directory is /opt/rational/clearcase on UNIX and 
C:\Program Files\Rational\ClearCase on Windows. 

■ cquest-home-dir represents the directory into which Rational ClearQuest has been 
installed. By default, this directory is /opt/rational/clearquest on UNIX and 
C:\Program Files\Rational\ClearQuest on Windows. 

Integration Description Where it is documented

ClearQuest-
Base ClearCase

Associates change requests 
with versions of ClearCase 
elements.

ClearCase: Developing Software 
ClearCase: Managing Software 
Projects

ClearQuest: Administrator’s Guide

ClearQuest-PurifyPlus Allows developers to invoke 
ClearQuest from PurifyPlus.

PurifyPlus Help
ClearQuest: Administrator’s Guide

ClearQuest- 
RequisitePro

Allows developers to invoke 
ClearQuest from RequisitePro 
and to associate requirements 
with ClearQuest change 
requests.

Rational Suite: Administrator’s Guide

ClearQuest: Administrator’s Guide

ClearQuest-SoDA Collects information from 
ClearQuest and presents it in 
various report formats.

Using Rational SoDA for Word 
Using Rational SoDA for Frame 
SoDA Help

ClearQuest-
Test Manager

Allows developers to invoke 
ClearQuest from TestManager.

Using Rational TestManager 
ClearQuest: Administrator’s Guide

ClearQuest-Robot Allows developers to invoke 
ClearQuest from Robot.

Rational Robot User’s Guide
Rational Robot Help

ClearQuest-UCM Links UCM activities to 
ClearQuest records.

ClearCase: Developing Software 
ClearCase: Managing Software 
Projects

ClearQuest: Administrator’s Guide
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■ Bold is used for names the user can enter; for example, command names and 
branch names.

■ A sans-serif font is used for file names, directory names, and file extensions.

■ A sans-serif bold font is used for GUI elements; for example, menu names and 
names of check boxes.

■ Italic is used for variables, document titles, glossary terms, and emphasis. 

■ A monospaced font is used for examples. Where user input needs to be 
distinguished from program output, bold is used for user input.

■ Nonprinting characters appear as follows: <EOF>, <NL>. 

■ Key names and key combinations are capitalized and appear as follows: SHIFT, 
CTRL+G.

■ [ ] Brackets enclose optional items in format and syntax descriptions.

■ { } Braces enclose a list from which you must choose an item in format and syntax 
descriptions.

■ | A vertical bar separates items in a list of choices.

■ ... In a syntax description, an ellipsis indicates you can repeat the preceding item 
or line one or more times. Otherwise, it can indicate omitted information.

Note: In certain contexts, you can use “...” within a pathname as a wildcard, similar 
to “*” or “?”. For more information, see the wildcards_ccase reference page.

■ If a command or option name has a short form, a “medial dot” ( ⋅ ) character 
indicates the shortest legal abbreviation. For example:

lsc·heckout 

Customer Support

If you have any problems with the software or documentation, contact Rational 
Customer Support by telephone or fax. You can find information about support hours, 
languages spoken, or other support information at 
www.ibm.com/software/rational/support/.

Your location Telephone Facsimile

Asia Pacific 61-2-9419-0111
Australia

61-2-9419-0123
Australia
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Europe, Middle 
East, and Africa

+31-(0)20-4546-200
Netherlands

+31-(0)20-4546-201 
Netherlands

Latin America and 
Mexico

+1-408-863-4000
Cupertino, CA

Use either location
+1-408-863-4194
Cupertino, CA

+1-781-676-2460
Lexington, MA

United States and 
Canada

1-800-IBM-SERV Use either location
+1-408-863-4194
Cupertino, CA

+1-781-676-2460
Lexington, MA
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1Before You Install
This chapter describes the supported software and hardware platforms, the hardware 
and software requirements, and the language support. 

■ If you are upgrading Rational ClearQuest, see Chapter 7, Upgrading ClearQuest.

■ If you are installing Rational ClearQuest MultiSite, see Chapter 6, Postinstallation 
and Administration.

■ If you are installing Rational ClearQuest for the first time, you must complete the 
prerequisite installations, as described in Chapter 2, Configuring Vendor Databases.

The Release 2003.06.00 media kit contains release images which support the following 
platforms:
■ Windows
■ Solaris Sparc
■ HP-UX
■ AIX
■ Red Hat Linux

ClearQuest Database Configurations in a UNIX 
Environment

ClearQuest supports three vendor databases in a UNIX environment:

■ SQL Server

■ Oracle

■ DB2

Regardless of which database you use, you can configure ClearQuest to support the 
following:

■ ClearQuest supports two types of clients that access a ClearQuest user database: a 
native client and a Web client. In general, client users can create and update 
ClearQuest records in a user database.
© Copyright IBM Corp. 1997, 2003 1



 

■ The ClearQuest administrator uses the ClearQuest Administration Tools, which 
are installed only on a Windows operating system, to configure the schema 
repository and user databases for ClearQuest clients. For more information about 
installing the Administration Tools, see the Installation Guide for Rational Server 
Products.

■ If you are using ClearQuest MultiSite on UNIX, you must install the MultiSite 
Administration Tools (multiutil and its subcommands) on Windows. For more 
information about installing ClearQuest MultiSite Administration Tools on 
Windows, see the Installation Guide for Rational Server Products.

Each supported database has specific configuration requirements. For more 
information, see Table 3 and Table 5.
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Figure 1 ClearQuest Environment with an Oracle Database

When using an Oracle database, an Oracle client must be installed and configured on 
the ClearQuest administrator host and the ClearQuest Web host (if you are using 
ClearQuest Web). In addition, OpenLink Broker must also be installed and configured 
on the Oracle database host (Figure 1).
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Figure 2 ClearQuest Environment with a SQL Server Database

When using a SQL Server database, OpenLink Broker must be installed and configured 
on the SQL Server database host (Figure 2).
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Figure 3 ClearQuest Environment with a DB2 Database

When using a DB2 database, a DB2 client must be installed and configured on the 
ClearQuest administrator host, the ClearQuest Web host (if you are using ClearQuest 
Web), and all native client hosts (Figure 3).

Configuring ClearQuest for Remote Use

After you install a native client on a supported UNIX host, that host can be accessed by 
remote UNIX hosts of the same architecture. Although the remote UNIX hosts do not 
have the native client installed, they can run ClearQuest on the network host. The 
remote hosts can also use the ClearQuest database registry directory, which is 
configured on the native client host. For more information, see Recommended 
Postinstallation Tasks for the Network Install on page 83.
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When installing a native client, you must specify a path for the ClearQuest database 
registry directory for the database connection information. This directory can either 
reside on the local host in the default location or be an absolute path to a shared 
location on any network host. By using a shared location, all native clients and remote 
UNIX clients can use the same database connection information.

ClearQuest MultiSite Configuration for UNIX

To use ClearQuest MultiSite on UNIX, you must install the following ClearQuest 
MultiSite components on a Windows machine:

■ MultiSite Administration Tools (multiutil and its subcommands)

■ Rational Shipping Server (shipping_server, mkorder, and the shipping.conf file)

This release of ClearQuest MultiSite does not support installing multiutil or the 
Rational Shipping Server on a UNIX machine. Support for these components on UNIX 
will be available in a future release.

Component Locations

You have several options for where to install the MultiSite Administration Tools and 
the Rational Shipping Server on Windows. Because many MultiSite operations access 
the database server, you may choose to install the MultiSite Administration Tools on 
the database server. However, you should do this only if your database server machine 
has enough memory and processing power to handle the extra work. The following are 
suggested component locations:

■ Install MultiSite Administration Tools and Rational Shipping Server on a Windows 
database server.

■ Install MultiSite Administration Tools on a Windows database server and install 
Rational Shipping Server on a separate Windows machine.

■ Install MultiSite Administration Tools and Rational Shipping Server on the 
MultiSite administrator’s host.

■ Install MultiSite Administration Tools and Rational Shipping Server on separate 
Windows machines; neither component is located on the database server.

Note: If you install the ClearQuest MultiSite Administration Tools on the same machine 
as your SQL Server 7.0 or 2000 database, the ClearQuest MultiSite commands may fail 
if the SQL Server Client software is not installed also.
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Rational Shipping Server

When you use ClearQuest MultiSite, one or more hosts in the network act as 
synchronization servers. These machines host the Rational Shipping Server and 
transfer packets to other sites. 

ClearQuest MultiSite and ClearCase MultiSite both use the same Rational Shipping 
Server. However, this release of ClearQuest MultiSite does not support installing the 
Shipping Server on a UNIX machine. For more information about installing the 
Rational Shipping Server on Windows, see the Installation Guide for Rational Server 
Products.

System Requirements

Table 1 and Table 2 define the operating system and hardware requirements. For more 
information, see Compatibility Issues on page 15.

Table 1 Supported Operating Systems  

Component Operating system

Native UNIX 
client

■ Solaris versions 2.6, 7-9
■ HP-UX versions 11.0,QPK1100, 11.11, GoldQPK11i and Bundle11i
■ AIX versions 4.3.3, 5.1, 5.2
■ Red Hat Linux versions 7.2, 7.3, 8.0, 9

Web clients For Web clients on UNIX
■ Netscape 4.72-4.78 on Solaris and HP-UX
■ Netscape 7.0 on Solaris and HP-UX
■ Mozilla 1.4 on AIX versions 5.1 and 5.2, and Red Hat Linux ver-

sions 7.2, 7.3, 8.0, 9, AS 2.1, ES 2.1, WS 2.1
Internet Explorer and Netscape require JVM 1.3.x or 1.4.x.
Mozilla requires JVM 1.4.x for Red Hat Linux and AIX.
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ClearQuest 
database 
server

A ClearQuest database server for UNIX native clients supports the 
following vendor databases:
■ Oracle 8.1.6
■ Oracle 8.1.7 (requires Release 3)
■ DB2 7.2 (requires Fixpack 8)
■ DB2 8.1
■ SQL Server
For more information on supported operating systems for the 
ClearQuest database server, see Table 3 and Table 4.

Table 2 Hardware Requirements 

Component Hardware Requirements

Web clients Processor ■ 32 bit
■ 128 MB RAM
■ 233 MHz 

Disk space 60 MB

UNIX client Processor ■ 32 bit
■ 128 MB RAM
■ 233 MHz 

Disk space ■ Full-Copy install on Solaris 211 MB
■ Standard install on Solaris 75 MB
■ Full-Copy install on HP-UX 204 MB
■ Standard install on HP-UX 97 MB
■ Full-Copy install on AIX 280 MB
■ Standard install on AIX 221 MB
■ Full-Copy install on Red Hat Linux 182 MB
■ Standard install on Red Hat Linux 126 MB

Table 1 Supported Operating Systems (Continued) 

Component Operating system
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Database Software Requirements 

Table 3 lists the supported databases and operating systems for the ClearQuest 
database.

Note: We recommend that you host the database server and the ClearQuest Web server 
on different machines. Putting both servers on the same host causes frequent hangs 
and script timeouts, and generally causes ClearQuest Web to be unreliable.

Database 
server

Processor ■ 32 bit
■ 500 to 1 GB RAM
■ 500 MHz or higher 
■ 2x physical memory is the recommended 

swap space 1

Disk space ■ 250 MB at minimum

1. More memory generally improves responsiveness; it depends on the number of concurrent users, 
amount of data being requested, and the size of the database.

Table 3 Supported Database Servers for a ClearQuest Environment Using UNIX 
Native Clients 

Oracle (32 bit) SQL Server DB2

Database Server 
Operating System 
Version

8.1.6
8.1.7 
(requires 
Release 3)

7.0, SP4 and 
2000, SP 2, 3

Universal 
Database 7.2 
(requires 
FixPack 8)

Universal 
Database 8.1

Windows 2000 
Server, Service Pack 
2, 3

X X X

Windows 2000 
Advanced Server, 
Service Pack 2, 3

X X X

Windows NT 4.0 
Workstation Service 
Pack 6a + SRP 
(Security Rollup 
Package)

X X X

Table 2 Hardware Requirements  (Continued)

Component Hardware Requirements
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Windows NT 4.0 
Server Service Pack 
6a + SRP (Security 
Rollup Package)

X X X

Solaris 2.6 X X

Solaris 7 X X

Solaris 8 X X

Solaris 9 X X

HP-UX 11.00 
QPK1100

X X

HP-UX 11.11 
GoldQPK11i and 
Bundle11i

X X

AIX 4.3.3 X X X X

AIX 5.1 X X

AIX 5.2 X

Red Hat Linux 7.1 X

Red Hat Linux 7.2 X X

Red Hat Linux 7.3 X X

Red Hat Linux 8.0 X

Red Hat Linux 9 X

Red Hat Enterprise 
Linux AS 2.1

X

Red Hat Enterprise 
Linux ES 2.1

X

Table 3 Supported Database Servers for a ClearQuest Environment Using UNIX 
Native Clients  (Continued)

Oracle (32 bit) SQL Server DB2

Database Server 
Operating System 
Version

8.1.6
8.1.7 
(requires 
Release 3)

7.0, SP4 and 
2000, SP 2, 3

Universal 
Database 7.2 
(requires 
FixPack 8)

Universal 
Database 8.1
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Table 4 defines the supported ClearQuest database for ClearQuest native clients on 
UNIX.

Red Hat Enterprise 
Linux WS 2.1

X

Table 4 Supported Native Clients on UNIX Accessing ClearQuest Databases 

Oracle (32 bit) SQL Server DB2

UNIX Native 
Client Operating 
System Version

8.1.6
8.1.7 
(requires 
Release 3)

7.0, SP4 and 
2000, SP 2, 3

Universal 
Database 7.2 
(requires 
FixPack 8)

Universal 
Database 8.1

Solaris 2.6 X X X X X

Solaris 7 X X X X X

Solaris 8 X X X X X

Solaris 9 X X X X X

HP-UX 11.00 
QPK1100

X X X X X

HP-UX 11.11 
GoldQPK11i and 
Bundle11i

X X X X X

AIX 4.3.3 X X X X X

AIX 5.1 X X

AIX 5.2 X X

Red Hat Linux 7.2 X X X X X

Table 3 Supported Database Servers for a ClearQuest Environment Using UNIX 
Native Clients  (Continued)

Oracle (32 bit) SQL Server DB2

Database Server 
Operating System 
Version

8.1.6
8.1.7 
(requires 
Release 3)

7.0, SP4 and 
2000, SP 2, 3

Universal 
Database 7.2 
(requires 
FixPack 8)

Universal 
Database 8.1
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Table 5 defines the supported databases and operating systems for the ClearQuest 
database when running ClearQuest MultiSite and using native clients on UNIX.

Red Hat Linux 7.3 X X X X X

Red Hat Linux 8.0 X X X X

Red Hat Linux 9 X X X X

Table 5  Supported Database Servers for ClearQuest MultiSite Environment 
Using UNIX Native Clients 

Oracle (32 bit)

Database Server Operating System 
Version

8.1.6
8.1.7 (requires 
Release 3)

Solaris 2.6 X X

Solaris 7 X X

Solaris 8 X X

Solaris 9 X X

HP-UX 11.00 QPK1100 X X

HP-UX 11.11 GoldQPK11i and Bundle11i X X

AIX 4.3.3 X X

AIX 5.1

AIX 5.2

Red Hat Linux 7.1 X

Red Hat Linux 7.2

Table 4 Supported Native Clients on UNIX Accessing ClearQuest Databases  
(Continued)

Oracle (32 bit) SQL Server DB2

UNIX Native 
Client Operating 
System Version

8.1.6
8.1.7 
(requires 
Release 3)

7.0, SP4 and 
2000, SP 2, 3

Universal 
Database 7.2 
(requires 
FixPack 8)

Universal 
Database 8.1
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Installation Overview

To install ClearQuest and ClearQuest MultiSite for the first time:

1 Install prerequisite software. See System Requirements on page 7

2 Create a networkwide resource. See Chapter 4.

Establish a release area on a release host. This task is a prerequisite to installing 
ClearQuest on any host in your network. Because you cannot install directly from 
the CD, you must load the files to a release host to make them available over the 
network. 

3 Install ClearQuest on individual hosts. See Chapter 5.

4 Perform postinstallation configuration procedures. See Chapter 6.

After ClearQuest is installed on individual hosts, the ClearQuest environment 
must be configured. 

If this installation is an upgrade from a previous release, upgrade your existing 
databases to allow access to the new features. For more information, see Chapter 7.

Before you install ClearQuest, you must complete these tasks:

1 Set up your vendor database product. See Chapter 2.

2 Set up your license server. See Chapter 3, Configuring ClearQuest Licensing. If you 
are installing ClearQuest MultiSite, set up a license server for both ClearQuest and 
ClearQuest MultiSite.

Red Hat Linux 7.3

Red Hat Linux 8.0

Red Hat Enterprise Linux AS 2.1

Red Hat Enterprise Linux ES 2.1

Red Hat Enterprise Linux WS 2.1

Table 5  Supported Database Servers for ClearQuest MultiSite Environment 
Using UNIX Native Clients  (Continued)

Oracle (32 bit)

Database Server Operating System 
Version

8.1.6
8.1.7 (requires 
Release 3)
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3 If using the ClearQuest Web interface, install supported Web browsers. See Install 
Supported Web Browsers on page 14.

4 Install ClearQuest Administration Tools on Windows. See Install ClearQuest 
Administration Tools on page 14.

5 (Optional) If you plan to use the Rational Shipping Server with ClearQuest 
MultiSite, you must install it on a Windows machine:

❑ If ClearCase is installed on Windows, install ClearCase MultiSite from the 
ClearCase Installation CD. The Rational Shipping Server is included in the 
ClearCase MultiSite installation.

❑ If ClearCase is not installed on Windows, install the Rational Shipping Server 
from the ClearCase Installation CD.

6 (Optional) If you want to use ClearQuest MultiSite, install ClearQuest at the 
replica sites. For more information, see the Administrator’s Guide for Rational 
ClearQuest MultiSite.

Install Supported Web Browsers

If you are planning to use the ClearQuest Web interface, you must ensure that all UNIX 
client hosts accessing the ClearQuest Web have the appropriate version of supported 
browsers. For more information, see Table 1.

Install ClearQuest Administration Tools

Install ClearQuest Administration Tools on a Windows host. This tools are required to 
set up the ClearQuest schema repository and user databases. For more information, see 
the Installation Guide for Rational Server Products.

Install an Oracle Client

To access an Oracle database, Oracle Client Software must be installed on the 
administrator host. To install this software, see the Oracle Networking Products 
documentation. 

Install a DB2 Client

To access a DB2 database, DB2 client software must be installed on the administrator 
host and all native clients on UNIX. To install DB2 client software, see the IBM 
documentation.
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Compatibility Issues

This section describes the compatibility issues of ClearQuest release 2003.06.00 with 
other Rational products and third-party products.

Rational Products

This section describes compatibility issues with other Rational products.

Interoperation Between Versions

It is possible to interoperate between different versions of ClearQuest when one 
version is on Windows and a different version is on UNIX. For more information, see 
the Administrator’s Guide for Rational ClearQuest.

Integrations with ClearCase and MultiSite

The ClearQuest integration with UCM and base ClearCase is designed to work in a 
MultiSite deployment. Both integrations require ClearCase release 4.2 or higher. For 
more information about using ClearQuest MultiSite integration with ClearCase, see 
Solutions #22587.

MultiSite UCM Integration

The ClearQuest UCM package works in a MultiSite deployment. If you plan to use 
ClearQuest MultiSite with the UCM integration, you must upgrade your UCM 
package to the latest version.

MultiSite Version Interoperability

MultiSite synchronization servers must run ClearQuest version 2002.05.01 Patch 02, 
2002.05.01 Patch 03, or 2003.06.00. We recommend that you upgrade all ClearQuest 
clients to version 2003.06.00 if you use a MultiSite 2003.06.00 synchronization server.

ClearCase MultiSite and the Rational Shipping Server

If you are using ClearCase MultiSite and the Rational Shipping Server on the same 
computer and uninstall one of those products, the other product is partially uninstalled 
and stops working. To resolve the problem, you must uninstall both products and 
reinstall the product you need.

Note: This version of ClearQuest MultiSite does not support the Rational Shipping 
Server on UNIX. 
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Database Connections When ClearQuest Is Uninstalled

The ClearQuest MultiSite command-line interface, multiutil, uses a unique database 
set name to access database replicas. When ClearQuest is uninstalled, the database set 
information on that host is removed. When you reinstall ClearQuest, the database set 
information must be re-created. To do so, in the ClearQuest Maintenance Tool, click 
Connection > New and provide the connection information for the schema repository at 
this site. You must name the connection using the format CQMS.clan_name.site_name.

Third-Party Products

This section describes compatibility issues with third-party products.

SQL Server 2000 

During the installation for SQL Server 2000, you can select authentication for Windows 
only or mixed mode (Windows and SQL Server) authentication. You must select mixed 
mode authentication.

Later in the installation process, you are prompted for a database instance name. This 
name must be the same as that of the host on which you are installing. To use the 
correct instance name, leave the instance name blank and accept the default. If an 
instance name is entered, several issues arise:

■ Clients running earlier versions of Microsoft Data Access Components (MDAC), 
such as 2.1.2, cannot connect to the database. 

■ UNIX clients cannot connect to the SQL Server database.

■ For the client host, you must install the SQL Server client or edit the registry 
manually. The following is an excerpt from the Microsoft white paper Upgrading to 
SQL Server 2000: 

“When using the SQL Server client connectivity components from SQL Server 7.0 
or earlier, you must set up an alias using the Client Network Utility before you 
connect to a named instance of SQL Server 2000. For example, on a SQL Server 7.0 
client, to connect to a named instance of SQL Server 2000, you must add an alias 
that points to \\computername\pipe\MSSQL$instancename\sql\query. If you use an alias 
name of computername\instancename, clients can connect by specifying this name in 
the same way as SQL Server 2000 clients do. For the TCP/IP Sockets and NWLink 
IPX/SPX Net-Libraries, you must use the Client Network Utility to define an alias 
on the client that specifies the port address on which the named instance is 
listening.”

For more information, see the Microsoft support Web site at support.microsoft.com. 
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Installing Web Browsers

To use the ClearQuest Web capability, ensure that your client machine has the 
appropriate browser versions. See System Requirements on page 7 for information on 
the supported browsers. To use ClearQuest Web and the Advanced Query Editor, 
install either Java Runtime Environment (JRE) 1.3.x or 1.4.x for a Netscape browser or 
JRE 1.4.2 for a Mozilla browser. If you are using Netscape Navigator or Mozilla to 
access ClearQuest Web, you are prompted to download a Java plug-in if a supported 
version of the Java plug-in is not enabled.

Adobe Reader Version 4.0

To read manuals in PDF format, you need Adobe Acrobat Reader, version 4.0 or later. 
Download the free Adobe Acrobat Reader from Adobe.com.

Language Support

The ClearQuest native client is only supported for installation on an operating system 
using an US English locale. ClearQuest databases supporting UNIX native clients must 
use the ASCII code page 20127.

Installing ClearQuest MultiSite at a Replica Site

To install ClearQuest MultiSite at a replica site:

1 Set up your database product. As the ClearQuest administrator, you are 
responsible for setting up the ClearQuest databases. See Chapter 2, Configuring 
Vendor Databases.

2 Set up your license server. See Licensing Rational software on page 32 and Licensing 
ClearQuest MultiSite on page 33.

3 Install the native client and the Rational Shipping Server on the appropriate hosts. 
Note that you can only install the Rational Shipping Server on Windows machines.

DO NOT create ClearQuest databases before you import a replica-creation packet.

Warning: A ClearQuest database is automatically created when you import a 
replica-packet packet into an empty vendor database. If you have created a 
ClearQuest database with the Maintenance Tool or ClearQuest Designer, the 
replica import will fail. Delete the vendor databases and create them again. 

4 Configure the shipping.conf file on the host. See the Administrator’s Guide for 
Rational ClearQuest MultiSite.
Chapter 1 - Before You Install 17



 

5 Determine the appropriate ClearQuest data code page value and vendor database 
character set to use for your MultiSite deployment. For more information, see the 
Administrator’s Guide for Rational ClearQuest.

6 Activate the database set you want to replicate and export replica-creation packets 
to all sites. After receiving replica-creation packets, import the packets into empty 
vendor databases. For instructions, see Creating Defect-Tracking Database Replicas in 
the Administrator’s Guide for Rational ClearQuest MultiSite.

7 Install ClearQuest on the client hosts and provide your users with the ClearQuest 
database connection information. See Chapter 6, Postinstallation and Administration.
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2Configuring Vendor 
Databases
After you install Rational ClearQuest, you must create and configure the vendor 
databases for use with ClearQuest, ClearQuest Web, and ClearQuest MultiSite.

These products require at least two databases:

■ A schema repository, which is the master database in which ClearQuest and 
ClearQuest MultiSite store the schema.

■ A user database, which stores data entered by ClearQuest users. You can have as 
many user databases as you need.

This chapter covers the following topics:

■ Choosing a Vendor Database on page 19

■ Setting Up Databases for ClearQuest MultiSite on page 20

■ Setting Up Microsoft SQL Server on page 21

■ Setting Up the Oracle Server on page 25

■ Setting Up IBM DB2 on page 28

Choosing a Vendor Database

You can use more than one vendor database for ClearQuest databases. For example, 
you may want to use an Oracle database for your schema repository and user 
databases and use a Microsoft SQL Server database for your test database. We 
recommend that you use the same vendor database with ClearQuest MultiSite because 
the case-sensitivity rules are not consistent between vendors.

When choosing a database vendor for the ClearQuest databases, see Table 3 on page 9 
and Table 5 on page 12 for supported versions of database products.

Case-Sensitivity Settings

Your case-sensitivity settings must be consistent in either of these situations:

■ You are moving your database to another database vendor.
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■ You are using ClearQuest MultiSite and multiple synchronized databases created 
with different vendor databases.

The following table summarizes the case-sensitivity properties of the supported 
vendor databases.

Supported Character Sets

The ClearQuest database, when supporting access by a UNIX client, supports only the 
ASCII character set.

For more information, see the Administrator’s Guide for Rational ClearQuest.

Setting Up Databases for ClearQuest MultiSite

If you are installing ClearQuest MultiSite, do not create additional databases at the 
replica site. For more information, see Installing ClearQuest MultiSite at a Replica Site on 
page 17

Note: If you are using the native client on UNIX with ClearQuest MultiSite, you cannot 
use an Oracle database on Windows. 

When you replicate an existing ClearQuest schema repository and user database, you 
must create empty databases at the new site, but do not create ClearQuest databases at 
the new site. 

Database 
product

Default setting Possible settings Comments

DB2 Case-sensitive Case-sensitive Case-sensitivity applies only to 
data, not to database object 
names.

SQL Server Case-insensitive, 
Case-sensitive 

Case-insensitive, 
Case-sensitive

Case-sensitivity applies to data 
and database object names.
Case-sensitivity can be 
specified either at the 
installation time or database 
creation time. 

Oracle Case-sensitive Case-sensitive The case-sensitivity applies 
only to data, not to database 
object names.
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Setting Up Microsoft SQL Server 

Install SQL Server 7 or 2000 on a supported platform (see System Requirements on 
page 7). For instructions, see the product documentation. 

Note: To use a SQL Server database with native clients on UNIX, you must specify an 
ASCII code page. For more information, see Using OpenLink Broker for ASCII Mode on 
page 74.

When installing SQL Server, follow these guidelines:

■ Your SQL Server databases must be in the same network domain as both your 
ClearQuest Web server and any ClearQuest clients or tools that must connect to 
the database. If they are not in the same domain, you will get errors. For more 
information:

❑ See the Microsoft KnowledgeBase Article Q152828 at http://www.microsoft.com/. To 
locate the article, click the Search at the top of the page, and enter the article 
number. 

❑ See the Rational Customer Support TechNote 8184, “How do I access an SQL 
Server database in another domain?” at 
http://www.ibm.com/software/rational/support/. 

■ Select one of the following sort-order options: 

❑ Dictionary order, case-sensitive.

❑ Dictionary order, case-insensitive.

If you change sort orders after installing SQL Server, you must rebuild the SQL 
databases and reload the data.

Note: Changing the sort orders affects the case-sensitivity of ClearQuest queries. 
If you want ClearQuest queries to be case-insensitive, set the order here. For 
more information, see Case-Sensitivity Settings on page 19.

■ You must set up an empty SQL Server database for the ClearQuest schema 
repository and an empty SQL Server database for each ClearQuest user database. 
To create the databases:

a Verify server registration.

b Create an empty database.

c Set up a backup procedure for the database.

■ Create an SQL Server login with the db_owner role to be used for the ClearQuest 
database logins. ClearQuest uses the same login for all connections.
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Note: Do not use the SA (system administrator) login. During an upgrade or move, 
ClearQuest requires empty databases. If you use the SA login, ClearQuest can see 
the system tables; it assumes the database is not empty and does not let the process 
continue.

When installing SQL Server 2000, it is important to select the default registration 
name for your database server, which makes the registration name the same as 
your server’s host name.

Registering the SQL Server Host 

You must first determine whether the host is registered. To do so, click Programs > 
Microsoft SQL Server 7.0 > Enterprise Manager or Programs > Microsoft SQL Server > 
Enterprise Manager. 

For SQL Server 2000, click Programs > Microsoft SQL Server > Enterprise Manager or 
Programs > Microsoft SQL Server > Enterprise Manager. Select your Windows server in 
the SQL Server Group.

If your server is registered, see Creating a SQL Server Database on page 23. If your server 
is not shown, register it now. To register your server:

1 Right-click the SQL Server Group and select New SQL Server Registration. The 
Register SQL Server Wizard appears. Click Next.

When installing SQL Server 2000, accept the default registration name for your 
database server. Doing so makes the registration name the same as your server’s 
host name.

2 Select a server name, and click Next.

Record the server name; you will use it during the ClearQuest installation.

3 On the Select an Authentication Mode page, select SQL Server Authentication, and 
then click Next.

4 Select Login automatically using my SQL Server account information. Type SA in the 
Login name box, and type your SA password in the Password box. Then click Next. 
(The SA user has the privilege to create logins and databases.)

5 Add this server to an existing group or create a new group. Then click Next.

6 Click Finish. The server appears in the list of servers.

7 In the status window, verify that registration has been completed successfully and 
then click Close.
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Creating a SQL Server Database

To create an empty database for the schema repository and the user database:

1 On the Start menu, click Programs > Microsoft SQL Server 7.0 > Enterprise Manager 
or Programs > Microsoft SQL Server > Enterprise Manager.

2 For SQL Server 7, double-click the server name in the SQL Server Group to open 
the Getting Started Taskpad in the right pane. Click administer SQL Server > create 
a database to start the Create Database Wizard.

For SQL Server 2000, double-click the server name in the SQL Server Group and 
then click the Wizards tab in the right pane. Click Setup a Database > Create a 
database to start the Create Database Wizard. Click Next.

3 In the Database name box, type the database name and specify a file system 
location for the database and the log. Click Next.

Note: Do not use spaces or nonalphanumeric characters in the database name. 
(Underscores are acceptable.)

4 Accept the default name for the database files and click Next. Define the database 
file growth parameters. Click Next.

Note: Allocate at least 50 MB for the schema repository and at least 15 MB for every 
1,000 records that you expect each user database to store.

5 Define the transaction log file growth parameters. Click Next.

6 Click Finish. 

7 Create a database maintenance plan.

You are prompted to create a Database Maintenance Plan. The Database 
Maintenance Plan Wizard helps you set up a database backup routine. We strongly 
recommend that you set up automated nightly backups for all ClearQuest 
databases.

For SQL Server 7:

To set the properties for the new database:

a Select the new database in the server’s databases folder.

b Right-click the database and click Properties.

c On the Options tab, select the following settings, which keep the log file from 
growing too large:

Select into / bulk copy 

Truncate log on checkpoint 
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d Click Apply.

For SQL Server 2000:

To control the log file size in SQL 2000, create a maintenance plan that performs a 
daily backup of both the database and log file.  The log file is then truncated each 
day after the daily backup.

8 Repeat Step 1 through Step 6 for each empty user database that you want to create.

Creating SQL Server Logins

You must create a db_owner login for each ClearQuest database (schema repository 
and each user database). To do so, select the db_owner role for each login that you 
create.

Note: Do not use the SA (system administrator) as the owner login of a ClearQuest 
database. During an upgrade or move, ClearQuest requires empty databases. If the SA 
login is used, ClearQuest can see the system tables; it assumes the database is not 
empty and does not let the process continue.

To create a db_owner login for the empty databases for the schema repository and user 
databases:

1 On the Start menu, click Programs > Microsoft SQL Server 7.0 > Enterprise Manager 
or Programs > Microsoft SQL Server > Enterprise Manager. 

2 In the left pane of the Enterprise Manager, expand the Security folder. Right-click 
Logins and click New Login to create a new user for the schema repository 
database. The SQL Server Login Properties - New Login dialog box opens.

3 On the General tab, select SQL Server Authentication. 

Note: ClearQuest requires a SQL Server login for each database and does not 
support Windows NT authentication. You must configure the SQL Server to 
operate in mixed mode (that is, Windows NT Authentication and SQL Server 
Authentication). To set this property by using Enterprise Manager, right-click the 
server and select Properties. In the Properties dialog box, on the Security tab, click 
Windows NT Authentication and SQL Server Authentication.

4 On the General tab, type a user name and password in the Name and Password 
boxes.

In the Defaults area, select your database and leave the Language set to <Default>.

5 On the Server Roles tab, verify that no server roles are granted on the Server Role 
list.
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6 On the Database Access tab, select the new database from the Permit list to grant 
the login permission. Under Permit in database role, select db_owner and public. Do 
not grant the user any other privileges.

7 Click OK and verify your password.

8 Repeat Step 1 to Step 7 for each ClearQuest user database that you have created. 
When repeating Step 2, double-click the user name that you created for the schema 
repository in the right pane of the Enterprise Manager. On the General tab, the 
information for the Name and Password boxes will be completed.

Ensuring SQL Server Client Connectivity

To ensure connectivity to ClearQuest database, the ClearQuest Administration Tools 
host requires Microsoft Data Access Components (MDAC) 2.7. If MDAC 2.7 is not 
present on the host when you install ClearQuest Administration Tools, it is installed. 
For more information, see the Installation Guide for Rational Server Products.

Setting Up the Oracle Server

If you are using an Oracle database, see the Oracle documentation to install and create 
the databases. To use interMediaText support for multiline searches, you must select 
interMediaText during the initial installation. If you are using Oracle 8.1.7, you must 
upgrade Oracle 8.1.7 to release 8.1.7.3 for Solaris, AIX, and Red Hat Linux or release 
8.1.7.4 for HP-UX. 

Note: To use an Oracle database with native clients on UNIX, you must specify an 
ASCII code page, when installing an Oracle database. For more information, see the 
Administrator’s Guide for Rational ClearQuest.

When you set up your Oracle databases, follow these guidelines:

■ Create an Oracle database instance or identify one to use for ClearQuest data.

■ Create two or more database user accounts (each with its login):

❑ The user login for the ClearQuest schema repository.

❑ One user login for each ClearQuest user database.

■ Grant each user login the Connect and Resource roles only.

Note: We recommend that you associate each database user with a unique default 
tablespace. In the Oracle database, users can share the temporary tablespaces, but these 
must be separate from the Oracle system tablespace.
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Note: Oracle is a case-sensitive database. If you are using ClearQuest MultiSite or want 
to migrate to a different vendor, you should evaluate your database case-sensitivity 
settings. For more information, see Case-Sensitivity Settings on page 19.

Installing and Configuring an Oracle Client

The ClearQuest administrator host cannot access the ClearQuest database unless the 
Oracle Client Software is installed on it. To install Oracle Client Software, see the Oracle 
product documentation. After the installation is complete, the Net8 Assistant starts, 
which lets you create a database alias. See Creating an Oracle Database Alias on page 66.

Enhancing Oracle Search Capabilities

In a standard Oracle installation, you cannot perform a string search on multiline text 
boxes. For example, you cannot search for text in a multiline Notes box in ClearQuest.

To enable Multiline search, the interMediaText packages must be installed on the 
Oracle server. When installed, multiline text boxes become available for queries in 
ClearQuest.

Enabling Oracle Multiline Search

Note: Before you can configure interMediaText for multiline searches for Oracle 8.1.7, 
you must upgrade to release 8.1.7.3 for Solaris, AIX 4.3.3, Red Hat Linux 7.1 and release 
8.1.7.4 for HP-UX . After you complete the upgrade, follow the postinstallation 
instructions in the Oracle 8i Data Server Patch Set Notes before you configure 
interMediaText.

To enable Oracle multiline text search for Oracle 8.1.6 or 8.1.7.3 running on Solaris, AIX, 
and Red Hat Linux or Oracle 8.1.6 or 8.1.7.4 running on HP-UX:

1 Verify that interMediaText is installed. Generally, it is installed when the Oracle 
server is installed. Verify that the installation has created an Oracle user login for 
the ctxsys user before running the scripts to configure interMediaText.

2 If you have not created the ClearQuest schema repository and user database, run 
the ClearQuest Maintenance Tool from the ClearQuest administrator host to create 
the schema repository and user database. For more information, see Creating the 
ClearQuest Databases on page 67.

3 Create the directory $ORACLE_HOME/ctx/log on the Oracle server host.

4 Start the ctxsrv application on the Oracle database host. Note, the -personality 
parameter is optional. For example, from the Oracle database server, run the 
following command:
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% ctxsrv -user ctxsys/ctxsys@database-alias-name -personality M -log 
$ORACLE_HOME/ctx/log/ctx.log &

ctxsys/ctxsys is the default user name and password and database-alias-name is the 
Oracle database alias.

Note: Run ctxsrv in the background. Oracle does not provide a means to start this 
server at boot time; you must either run these processes manually or develop a 
shell script for that purpose.

5 To give the necessary privileges to the ClearQuest user, run the SQL 

setup_cq_ora_user.sql script. To do so, use the Oracle SQL*Plus utility as the 
Oracle ctxsys user.

The SQL script (setup_cq_ora_user.sql) is available in the ClearQuest installation 
directory (drive:\Program Files\Rational\ClearQuest) on the ClearQuest administrator 
host. Run the following command from the ClearQuest administrator host on 
which an Oracle client is installed and configured for the Oracle database alias:

cd drive:\Program Files\Rational\ClearQuest
sqlplus ctxsys/ctxsys@database-alias-name @setup_cq_ora_user.sql cquser

where cquser is the name of the Oracle login used for creating the ClearQuest 
database.

6 To set up the text indexes required for multiline searches, run the SQL script 
setup_cq_intermedia.sql, which is available in the ClearQuest installation 
directory on the ClearQuest administrator host. For example:

cd drive:\Program Files\Rational\ClearQuest
sqlplus cquser/password@database-alias-name @setup_cq_intermedia.sql

where cquser is the name of the Oracle login used to create the ClearQuest 
database.

Caution: This script must be run for each user database. But do not run it until the 
database has been created (either in ClearQuest Maintenance Tool or ClearQuest 
Designer). If the database does not exist, the script cannot find the necessary 
ClearQuest tables.

Enabling Oracle CLOB Data Type Support

This release of ClearQuest supports a new Oracle data type called CLOB. See the 
Release Notes for guidelines when specifying either CLOB or LONG as the data type for 
new Oracle databases. For more information, see Creating the ClearQuest Databases on 
page 67.
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Setting Up IBM DB2

To use ClearQuest with IBM DB2 databases, you must install a supported release of 
DB2 on your database server. Table 3 on page 9 and Table 5 on page 12 list supported 
versions of DB2. You cannot make a connection between a DB2 8.1 client and DB2 7.2 
server. The following are the supported combinations:

■ DB2 7.x client to DB2 7.x server

■ DB2 7.x client to DB2 8.1 server

■ DB2 8.1 client to DB2 8.1 server

Using any other combination of client and server versions is neither supported nor 
recommended.

Note: To use a DB2 database with native clients on UNIX, you must specify an ASCII 
code page, when installing a DB2 database. For more information, see the 
Administrator’s Guide for Rational ClearQuest.

Note: DB2 is a case-sensitive database. If you are using ClearQuest MultiSite or want to 
migrate to a different database vendor, you should evaluate your database 
case-sensitivity settings. For more information, see Case-Sensitivity Settings on page 19.

Creating a DB2 Database

You must set up an empty DB2 database for the schema repository and for each user 
database. 

For DB2 7.x

To create a DB2 database:

1 Click Start > Programs > IBM DB2 > Control Center. 

2 Enter the login name and password for the DB2 administrator account and click 
OK.

3 In the DB2 Control Center, expand the host name that corresponds to the database 
server name. 

4 Ensure that all DB2 services are running on the DB2 server host. Right-click the 
Databases folder and click Create > Database using Wizard.

Note: If the database creation is not successful, run the following command:

db2>
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db2> connect to database-name

db2> bind db2schema.bnd blocking all grant public

db2> disconnect all

5 In the Database name box, type the name of the database.

Note: DB2 supports database names of up to eight characters.

6 Select a default drive and type an alias name in the Alias box. Optionally, provide a 
comment in the Comment box. Click Finish.

7 Expand the Database name folder for the database you have created.

8 Right-click the Buffer Pools folder and then click Create. In the Create Buffer Pool 
dialog box:

a Type a Buffer pool name (such as BFP16K) and set Page size to 16.

b Accept the default for Size in 16 KB pages.

c Clear the Use extended storage and Use default bufferpool size check boxes if 
they are selected. 

d Click OK.

9 Right-click the DB2 folder, and click Stop. Select the Disconnect all applications 
check box in the Confirm Stop dialog box. Then, from the DB2 folder, click Start to 
restart the database with buffer pool activated.

10 Under the database-name folder for the database you have created, right-click the 
Table Spaces folder and click Create > Table space. In the Create Table Space dialog 
box:

a Type a name in the Table space name box (for example: TSPRGR16K), set the 
Type of table space to Regular and set Space management to System. 

b In the Container name section, click Add. In the Add Container dialog box, type 
a name in the Container box (for example; cntr1a_16K) and click OK. The 
container name then appears in the Create Table Space dialog box.

11 Click Advanced to open the Advanced dialog box:

a Set Page size to 16; then select the buffer pool name created in Step 8 and click 
OK.

b Click OK to close the Create Table Space dialog box.

c In the right pane of the Control Center, right-click the new tablespace name you 
have created and select Privileges.
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d On the Group tab, click Add, select the Public group, and click OK. Set the 
Privileges: Use area to Yes and click OK.

12 Under the database-name folder for the database you have created, right-click the 
Table Spaces folder and click Create > Table space. In the Create Table Space dialog 
box:

a Type a name in the Table space name box (for example: TSPTMP16K), set Type 
of table space to System Temporary and set Space management to System. 

b In the Container name section, click Add. In the Add Container dialog box, type 
a name in the Container box (for example; cntr1b_16K) and click OK. The 
container name then appears in the Create Table Space dialog box.

13 Click Advanced in the Advanced dialog box:

a Set Page size to 16; then select the buffer pool name created in Step 8 and click 
OK.

b Click OK to close the Create Table Space dialog box.

14 Right-click the DB2 folder, and click Stop. Select the Disconnect all applications 
check box in the Confirm Stop dialog box. Then, from the DB2 folder name, click 
Start to restart the database using the larger page size.

15 In the left pane of the Control Center, for each database created, right-click the 
database-name folder and select Configure to open the Configure Database dialog 
box.

a On the Performance tab, set the values for Application heap size, Application 
control heap size, and Sort heap size to 1024.

b On the Log tab, set the values for these parameters: Log File size to 1000, Number 
of Primary Log Files to 15, and Number of Secondary Log Files to 10. 

c Click OK.

16 Right-click the DB2 folder and click Stop. Then click Start to restart the database 
with the configuration parameters.

For DB2 8.1

To create a DB2 database:

1 Click Start > Programs > IBM DB2 > General Administration Tools > Control Center.

2 Enter the login name and password for the DB2 administrator account and click 
OK.
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3 In the DB2 Control Center, expand the host name that corresponds to the database 
server name. 

4 Ensure that all DB2 services are running on the DB2 server host. Right-click the 
Databases folder and click Create > Database using Wizard.

Note: If the database creation is not successful, run the following command:

db2>

db2> connect to database-name

db2> bind db2schema.bnd blocking all grant public

db2> disconnect all

5 In the Database name box, type the name of the database.

Note: DB2 supports database names of up to eight characters.

6 Select a default drive and type an alias name in the Alias box. Optionally, provide a 
comment in the Comment box. Click Finish and then click No when prompted to 
start the Configuration Advisor.

7 Expand the Database name folder for the database you have created.

8 Right-click the Buffer Pools folder and then click Create. In the Create Buffer Pool 
dialog box:

a Type a Buffer pool name (such as BFP16K) and set Page size to 16.

b Accept the default for Size in 16 KB pages.

c Clear the Use extended storage and Use default bufferpool size check boxes if 
selected. 

d Click OK.

9 Right-click the DB2 folder, and click Stop. Select the Disconnect all applications 
check box in the Confirm Stop dialog box. Then, from the DB2 folder, click Start to 
restart the database with buffer pool activated.

10 Under the database-name folder for the database you have created, right-click the 
Table Spaces folder and click Create > Table space. In the Create Table Space 
Wizard:

a Type a name in the Table space name box (for example: TSPRGR16K) and then 
click Next.

b Set the type of table space to Regular and then click Next.

c Select the buffer pool that you created in Step 8 and then click Next.

d Set space management to System-managed space and then click Next.
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e On the Define containers for this table space page, click Add. In the Define 
Container dialog box, type a name in the Container box (for example; 
cntr1a_16K) and click OK. The container name then appears on the Define 
containers for this table space page. Click to select this container name and then 
click Next. 

f On the Specify the extent and prefetch sizes for this table space page, click to 
select the average size of a table in this table space. Click Next.

g On the Describe hard drive specification page, define the specifications for the 
hard drive where the DB2 database resides. Click Next.

h On the Specify the dropped table recovery option for your new table space page, 
if you want to recover the table space, click the Enable dropped table recovery 
option. Click Next and then click Finish.

11 In the right pane of the Control Center, right-click the new tablespace name you 
have created and select Privileges. On the Group tab, click Add, select the Public 
group, and click OK. Set the Privileges: Use area to Yes and click OK.

12 Under the database-name folder for the database you have created, right-click the 
Table Spaces folder and click Create > Table space. In the Create Table Space 
Wizard:

a Type a name in the Table space name box (for example: TSPTMP16K) and then 
click Next.

b Set the type of table space to System temporary and then click Next.

c Select the buffer pool that you created in Step 8 and then click Next.

d Set space management to System-managed space and then click Next.

e On the Define containers for this table space page, click Add. In the Define 
Container dialog box, type a name in the Container box (for example; 
cntr1b_16K) and click OK. The container name then appears on the Define 
containers for this table space page. Click to select this container name and then 
click Next. 

f On the Specify the extent and prefetch sizes for this table space page, click to 
select the average size of a table in this table space. Click Next.

g On the Describe hard drive specification page, define the specifications for the 
hard drive where the DB2 database resides. Click Next.

h On the Specify the dropped table recovery option for your new table space page, 
if you want to recover the table space, click the Enable dropped table recovery 
option. Click Next and then click Finish.
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13 Right-click the DB2 folder, and click Stop. Select the Disconnect all applications 
check box in the Confirm Stop dialog box. Then, from the DB2 folder name, click 
Start to restart the database using the larger page size.

14 In the left pane of the Control Center, for each database created, right-click the 
database-name folder and select Configure Parameters to open the Database 
Configuration dialog box.

a Under the Performance section, set the values for APP_CTL_HEAP_SZ, 
APPLHEAPSZ, and SORT_HEAP to 1024.

b Under Logs section, set the values for LOGFIL_SIZ to 1000, LOGPRIMARY to 15, 
and LOGSECOND to 10. 

c Click OK.

15 Right-click the DB2 folder and click Stop. Then click Start to restart the database 
with the configuration parameters.

Installing a DB2 Client

To use the DB2 database, all ClearQuest native clients on UNIX and the ClearQuest 
Administration Tools host must install DB2 client software on their local hosts. To 
install DB2 client software, see the IBM documentation.

Note: The DB2 Administration Client must be installed on all hosts.

Creating a DB2 Database Alias

Before using ClearQuest native clients on UNIX or the ClearQuest Administration 
Tools on Windows, all users must create a DB2 database alias. For more information, 
see Configuring a Database Alias to Connect Native Clients to a DB2 Database on page 71 
and Creating a DB2 Database Alias on page 65.
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3Configuring 
ClearQuest Licensing
This chapter explains licensing tasks for installing Rational ClearQuest as a new point 
product.

Rational ClearQuest uses Rational Common Licensing, a model based on FLEXlm, the 
license management tool from GLOBEtrotter Software, Inc. It requires suite or 
ClearQuest licenses to run ClearQuest programs or issue ClearQuest commands.

Licenses are usually set up when a Rational Suite product is installed. If you have 
installed a Rational Suite product, you can skip this chapter. If you are adding 
ClearQuest to your system, you must request new license keys. You cannot use the 
existing suite licenses for new installations of point products. 

To configure ClearQuest licensing, you must first determine the type of licenses you 
will use:

■ Node-locked licenses. If you choose node-locked licenses, you must specify in the 
license map file that ClearQuest is to use the Rational Suite license keys. For 
information about modifying settings in the license map file, see Customizing 
License Usage Order on page 45.

■ Floating licenses. If you choose floating licenses, you must set up a license server 
to control the use of the licenses. After a period of inactivity, a ClearQuest user’s 
license may be taken by another user. For information about setting up a license 
server, see Using license_setup on page 37.

You must also choose between temporary licenses and permanent licenses:

■ Temporary licenses. Startup, temporary, or evaluation licenses are provided on 
the Rational License Key Certificate included with your product’s release media. 

■ Permanent licenses. Permanent or Term License Agreement (TLA) licenses can be 
obtained from the Rational AccountLink Web site or, if you do not have Internet 
access, by fax. For more information, see Using AccountLink on page 36.

This following sections explain these licensing procedures:

■ Acquiring licenses for ClearQuest from the AccountLink Web site: see Using 
AccountLink on page 36.

■ Setting up a license server host: see Using license_setup on page 37.
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■ Installing permanent or temporary license keys on a new or existing license server 
host: see Licensing Options on page 41.

■ Administering licenses: see Administering Licenses on page 43.

Using AccountLink

The AccountLink Web site, www.rational.com/accountlink, simplifies the process of 
obtaining license keys for ClearQuest and other Rational products. To use 
AccountLink, gather the information for the license request form; then use any Web 
browser to access the AccountLink Web site.

Note: If you are using the temporary or evaluation license key, you can skip this section.

Information You Need for AccountLink

In addition to contact information, you must provide the account and product 
information in Table 6 to obtain a file containing ClearQuest license keys. 

Table 6 AccountLink Information 

Data Notes Your entry

Your Rational account 
number

Source: Your Rational license key 
certificate.

License type Floating or node-locked for ClearQuest 
licenses; floating or node-locked for 
suite licenses

Rational product line ClearQuest is part of the ClearQuest 
product line.

CLEARQUEST

Product name Source: Your Rational license key 
certificate.

Rational ClearQuest

Quantity Source: Your Rational license key 
certificate. This is the number of licenses 
that you have purchased.
36 Installation Guide



  
When the process is complete, you will receive a file named license_for_server name.upd 
by e-mail.

If you have chosen to use floating licences, you must run license_setup to set up a 
license server.

Using license_setup

After you obtain your licenses, you can run license_setup to install the licenses on an 
existing license server or to set up a new license server to which you can add the 
licenses. 

Note: In this document, the pathname where the license server is installed is referred 
to as rational_dir.

Information You Need for license_setup

Before you run license_setup, collect all the information in Table 7.

Host name and host ID This is the name and host ID of the 
server machine for floating licenses or 
the machine on which ClearQuest will 
be used for node-locked licenses.
If the license server host is different from 
the installation machine, you must have 
remote shell access from the installation 
machine to the license server host. In 
addition, the installation directory must 
be accessible from the license server 
host.
If you do not know the host ID of your 
license server host, download the tool 
gethostinfo.sh from AccountLink, and 
run it on the computer that will be your 
license server host.

Table 6 AccountLink Information  (Continued)

Data Notes Your entry
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Table 7 License Request Information 

Data Notes Your entry

Host name or IP 
address of the 
computer on 
which the license 
server is to run

If this computer (the license server host), 
is different from the installation host, 
you must have remote shell access from 
the installation machine to the license 
server host. In addition, the installation 
directory must be accessible from the 
license server host.

License server 
port number

Default is 27000. This is the port at which 
the license server listens for license 
requests. This port number must not be 
in use by any other application on the 
license server host. Use ypcat to list ports 
in use on a host, or look in /etc/services.

Pathname of 
installation 
directory

If you are installing a Rational License 
server, rational_dir is the directory in 
which you will install Rational Common 
Licensing software. If you are using an 
existing Rational License server, 
rational_dir is the pathname under which 
the server is installed.

Pathname of 
license file

The installation program will suggest a 
default for a new license file. If you want 
to use an existing license file, enter its full 
pathname instead of the default.

License keys for 
each product you 
are installing
OR
Full pathname of 
the .upd file to 
import licenses 
from

Source: Your Rational license key 
certificate (temporary or evaluation 
keys)
OR
Rational AccountLink (.upd file with 
permanent or TLA keys).
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If you are going to set up a new Rational License server, select an appropriate host 
computer first.

Selecting a License Server Host

When selecting a license server host, choose a computer with these characteristics:

■ Is highly available and infrequently rebooted

■ Is accessible over the network by all ClearQuest hosts. Only network access, as 
verified by a UNIX command like ping, is needed when a client requests a license. 
The ability to access the license server host’s file system is not required for any 
purpose other than adding new licenses to the host.

License key type Source: Your Rational license key 
certificate. Must be permanent, TLA, 
startup, or evaluation.
Note: To enter the permanent license key 
after you have been using a startup or 
evaluation license, see Replacing 
Temporary License Keys with Permanent 
License Keys on page 41.

License quantity Source: Your Rational license key 
certificate. (Note that 0=uncounted.)

License expiration 
date

If you have a permanent license, enter p.
Source for other license types: Your 
Rational license key certificate or an 
e-mail message from Rational Software.
If you have a startup or evaluation 
license, enter the date in the dd-mm-yyyy 
format. (The field is not case-sensitive.)

User IDs for 
everyone who will 
be using 
ClearQuest 
(optional)

You can use the Rational Common 
Licensing options file to provide tighter 
control over which users and groups can 
acquire licenses. If you do not want to 
exercise this level of control, 
license_setup will populate the file with 
“dummy” names, one for each license 
you have purchased, and all users will be 
able to acquire licenses.

Table 7 License Request Information  (Continued)

Data Notes Your entry
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Because ClearQuest does not need to run on the license server host, you can select any 
computer that satisfies these requirements. If the license server host has an architecture 
that ClearQuest supports, you can also install ClearQuest software there. 

Running license_setup from the Release Area

The license_setup program is included as part of the ClearQuest release area directory.

To run license_setup: 

1 Log on to the computer that will be the license server host. Log on as an ordinary 
user who has rights to create files in the directory where you intend to install the 
Rational Common Licensing server. Do not log on as root. Installing the Rational 
Common Licensing server while you are logged on as root will cause the Rational 
Common Licensing server processes to run as root, which is not necessary and can 
pose a security risk.

2 Go to the subdirectory within the networkwide release area for the appropriate 
architecture:

For a list of supported architectures and their abbreviations, see Architecture 
Mnemonics and mount Commands on page 50.

3 Run the license_setup program:

./license_setup 

The license_setup program presents the Licensing Options menu.

Running license_setup from a Client Installation

The license_setup program is included as part of the native client installation in the 
cquest-home-dir directory.

To run license_setup: 

1 Log on to the native client host as the user as the as same user who has run 
install_release on that host.

2 Go to native client installation directory:

3 Run the license_setup program:

# cd /net/bigserver/usr/cq_rls (typical release area) 

# cd sun5/clearquest (architecture-specific location within 
release area) 

# cd cquest-home-dir (client installation directory) 
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./license_setup 

The license_setup program presents the Licensing Options menu.

Licensing Options

The license_setup program supports three licensing options:

■ Use an existing Rational Common Licensing license file or server

■ Set up a permanent or TLA license file and server

■ Set up a temporary (evaluation or startup) license file

After you select an option, license_setup prompts you through the installation, 
providing detailed instructions along with default choices. The defaults appear in 
brackets, for example[2]. To accept a default, press RETURN. 

Using an Existing License File 

Select this option if you have an existing license file for version 2000.02.10 or later of 
Rational Suite DevelopmentStudio. Selecting this option does not upgrade the license 
server software.

Setting Up a Permanent or TLA License File and Server

Select this option to do either of the following:

■ To install a Rational Licensing server and then import a new license file obtained 
from AccountLink or by fax

■ To import a new license file to an existing Rational Licensing server

Setting Up a Temporary License File

Select this option if you are using temporary or evaluation licenses. The license key and 
related information are provided on the Rational License Key Certificate, which is 
included with your product’s release media.

Replacing Temporary License Keys with Permanent License Keys

If you have installed a temporary, startup, or evaluation license, you must install 
permanent licenses to continue to use the product. To install permanent licenses, use 
AccountLink to request the permanent license keys; then run license_setup and 
specify option 2.
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Running license_check from a Client Installation

The license_check program is included as part of the native client installation in the 
cquest-home-dir directory. After using license_setup, use license_check to validate that 
your native client installation is licensed.

To run license_setup: 

1 Log on to the native client host as the same user who has run install_release on 
that host.

2 Go to native client installation directory:

3 Run the license_check program:

./license_check 

The license_check program displays the Rational ClearQuest for UNIX - Configuration 
Selection Menu.

Common Questions About license_setup

This section contains answers to some common questions about the license_setup 
program.

Can I rerun parts of the installation? 

Yes. You can rerun license_setup whenever you need to add or change licenses. You 
can also run the license_check program to validate the license you already have. 
license_check is installed in the same directory as license_setup.

Do I have to reenter my license server information each time I install a product? 

No. You enter this information only once. The license_setup program saves the 
information you enter about yourself and about the host to be used as the license server 
for ClearQuest licenses in two text files in the rational_dir/defaults directory: 
license_setup.username, which contains information about you and your license server, 
and license_setup.CQUEST.release-number, which records product-specific information 
for ClearQuest. The license_setup program reports the location of these files when you 
quit the program. The next time you run license_setup, it uses the saved configuration 
information. 

# cd cquest-home-dir (client installation directory) 
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Do I need to install all my licenses on one server? 

No. You may spread your licenses out over several servers, as long as each client is 
configured to know which server to contact when requesting a license.

Which type of product license key should I install? 

If you already have your permanent license key, you can install it right away. If you do 
not, you must obtain a permanent key from AccountLink, as described in Using 
AccountLink on page 36, or use the temporary key on your Rational License Key 
Certificate. To ensure uninterrupted use of ClearQuest, install your permanent license 
key as soon as possible.

Administering Licenses

This section summarizes the process of allocating and licensing ClearQuest MultiSite, 
using the license manager, and customizing license usage order. For more information, 
see the License Management Guide for Rational Suite.

Licensing ClearQuest MultiSite

Any access to a replicated database requires both a ClearQuest and a ClearQuest 
MultiSite license. For more information, see the Administrator’s Guide for Rational 
ClearQuest MultiSite.

You can calculate the number of ClearQuest MultiSite licenses that your site needs by 
determining how many developers will access replicated databases. If all of your 
developers will access replicated databases, you need the same number of ClearQuest 
MultiSite licenses as ClearQuest licenses. If some developers will not access replicated 
databases, you can purchase fewer ClearQuest MultiSite licenses.

For example, a company has two sites, with 20 developers at site A and 5 developers 
at site B. The company has three databases at site A; two of them will be replicated to 
site B and one will not be replicated. Five developers at site A will access only the 
unreplicated database, and the remaining 15 will work in all databases. Therefore, the 
company needs to purchase the following numbers of licenses:

Site ClearQuest licenses ClearQuest MultiSite licenses

A 20 15

B 5 5
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Note: This example assumes that you purchase a ClearQuest license for each user. If 
you have fewer ClearQuest licenses than users, you can purchase a proportionate 
number of ClearQuest MultiSite licenses. For example, if site B purchased three 
ClearQuest licenses, it would also purchase three ClearQuest MultiSite licenses.

Using the License Manager

The Rational Common License Manager monitors license access, simultaneous use, 
idle time, and so on. It includes the following components: 

■ A vendor daemon named rational that dispenses ClearQuest licenses. The rational 
daemon is used for all licensed Rational Software products. 

■ A license manager daemon named lmgrd that is used by all licensed products that 
use license servers based on FLEXlm, such as Rational License server. The lmgrd 
daemon does not process requests on its own, but forwards requests to the 
appropriate vendor daemon. 

■ A license file that you maintain.

Verifying That Rational Common Licensing Is Working

After you install your license key, the license_setup program reminds you that you 
must configure your license host to restart the license server whenever it reboots. The 
license_setup program gives you instructions for doing this. 

To verify that your Rational Common Licensing is operational and that the daemons 
are running, type either of the following commands on your license server: 

# ps axw | grep -v grep | egrep "lmgrd|rational" 
# ps -e | grep -v grep | egrep "lmgrd|rational"

The output should include lines similar to the following (your pathnames will be 
different): 

538 ?? S 0:03.50 /rational/base/cots/flexlm.7.0f/platform/lmgrd

-c /rational/config/servername.dat

-l /rational/config/servername.log

539 ?? I 0:00.90 rational -T servername 6.0 3 -c ...

Using Rational Common Licensing Commands

The Rational Common Licensing License Manager supports the following commands 
for system administration.
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Customizing License Usage Order

By default, a Rational product requests licenses in this order:

1 Node-locked license 

2 Floating license

3 Suite license

4 Point-product license

For example, ClearQuest is sold as part of Rational Suite and as a stand-alone product. 
It requests the suite license before it requests a ClearQuest license. If a node-locked 
license is available among the group of suite licenses, it claims that license.

You can customize the license usage order in the License_Map file on a per-product 
basis. 

The License Map File

A default License_Map file is created and stored in the config subdirectory when you 
install a Rational Suite product. The file is initially set to claim a suite license for all 
products. It contains lines of the following format:

component_designator product_designator {, product_designator}

For ClearQuest, the initial setting should be similar to this:

ClearQuest:1.0 DevelopmentStudioUNIX:1.0, standalone

This line tells a ClearQuest license client to first request a Rational Suite 
DevelopmentStudio license. If a Rational Suite DevelopmentStudio license is 
unavailable, the client will request a stand-alone ClearQuest license. Depending on the 
Suite product you install, the line you see may differ from the example in this manual.

Command Description

lmdiag Diagnoses problems when you cannot check out a license

lmdown Shuts down the license and vendor daemons

lmhostid Reports the license manager host ID of a workstation 

lmreread Rereads the license file and starts new vendor daemons

lmstat Reports status on daemons and features used

exinstal Reports on licenses in the license file that you specify
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You can modify the settings to customize license usage for all users or for individual 
users. 

Run the user setup script (such as rs_setup.csh or rs_setup.ksh) to verify that the 
environment variable RSU_LICENSE_MAP_ENV is set. This environment variable is 
needed in finding the License_Map file to be used. If the environment variable is not set, 
the setup script sets the pathname to the default license map file, for example, 
config/License_Map.
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4Creating Networkwide 
Resources
Establishing a release area on a release host is a prerequisite to installing Rational 
ClearQuest on any host in your network. Because you cannot install directly from the 
CD to a host, you must load the files to a release host to make them available over the 
network. This chapter explains how to do this.

Selecting the Hosts for Networkwide Resources

You can have one host for the license server and the release host, or you can distribute 
across multiple hosts.

Release Host

One host in the network acts as the networkwide release host, housing a release area 
that provides storage for the entire ClearQuest distribution: executable files, 
configuration files, online documentation, and so on. This host is essentially a 
file-server host. It must be highly available, that is, with fast file system access, visible 
to all other ClearQuest hosts, robust, and infrequently rebooted.

Note: If you choose to install ClearQuest from the network, the UNIX file server must 
be NFS mountable by all ClearQuest client hosts and by the Oracle database server. 

ClearQuest programs do not need to run on the release host; thus, it can be a 
nonsupported architecture. For example, it can be a multi-tera-byte mass-storage 
system. (If the release host has an architecture that ClearQuest supports, you can also 
install the ClearQuest software there, enabling the host to access a ClearQuest database 
and to run ClearQuest administration and client programs.)

If you are upgrading from any previous ClearQuest release, see Chapter 7, Upgrading 
ClearQuest.

Note: Most examples in this chapter refer to specific architectural mnemonics, such as 
sun5, or to specific releases, such as 6.0 (for 2003.06.00). You will have to substitute 
mnemonics or release numbers appropriately. 
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Rational License Server Host

One or more hosts in the network act as license server hosts, as described in Chapter 3. 
A license server host must be highly available; if it becomes unavailable, so do the 
licenses defined in its license database file. (A user may be able to continue working for 
15 minutes or so after the link to the license server host fails.)

If you are upgrading from a previous release you can still use your existing license 
server host. The ClearQuest licensing scheme has not changed; thus, no licensing-level 
changes are required on that host.

Setting Up the Release Host

Setting up the release host involves the following steps:

1 Selecting a release area location. See Selecting a Release Area Location on page 48.

2 Exporting the release area. See Exporting the Release Area to Make It Accessible to All 
Hosts on page 49.

3 Loading files from the ClearQuest distribution media onto the release host’s file 
system. See Loading the Software Distribution from CD on page 50. 

4 Running the site_prep script. See Running the site_prep Script on page 51.

5 (Optional) Allowing non-root users to install ClearQuest on individual hosts. See 
site_prep Options on page 52. 

6 Setting the ownership and access modes of the release area and files. See Running 
the site_prep Script on page 51. 

7 Verifying site_prep selections. See Verifying site_prep Selections on page 53.

8 Ensuring that other hosts in the network can access the files. See Ensuring That the 
Release Area Is Accessible to All Hosts on page 54. 

9 Publicizing the location of the release area to all client hosts. See Publicizing the 
Location of the Release Area on page 54.

Selecting a Release Area Location

To select a release area location:

1 Log on as root to the computer you have selected to be the networkwide release 
host.

2 Decide where to create the ClearQuest release area, into which you will load the 
contents of the ClearQuest distribution medium. 
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Note: You must select a location in a file system that is (or can be) NFS-mounted by 
all current and prospective ClearQuest client hosts. Those hosts must not mount 
the release-area file system with the nosuid option. 

The file system must have sufficient disk space to hold the release area. For more 
information, see System Requirements on page 7.

By default, the directory for the release area is /usr/clearquest_rls.

Exporting the Release Area to Make It Accessible to All Hosts

Make sure that the release host exports the directory /usr/clearquest_rls. For details, see 
Table 8 on using the export command. 

Setting up the export is architecture specific; see Table 8. For details, see the standard 
reference pages for these files and programs. 

Table 8 Setting Up Export

Architecture Steps to export ClearQuest release area

Solaris SPARC  1. Revise /etc/dfs/dfstab:
share -F nfs -o options /usr/clearquest_rls 

2. Enter command: 
#/usr/sbin/shareall -F NFS

HP-UX 11  1. Revise /etc/exports: 
/usr/clearquest_rls options

2. Enter command: 
# /usr/sbin/exportfs -a other-options

AIX  1. Revise /etc/exports: 
/usr/clearquest_rls options

2. Enter command: 
# /usr/sbin/exportfs -a other-options

Red Hat Linux  1. Revise /etc/exports: 
/usr/clearquest_rls options

2. Enter command: 
# /usr/sbin/exportfs -a other-options
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Architecture Mnemonics and mount Commands

Table 9 provides the architecture mnemonic and sample mount commands for 
supported platforms. The architecture mnemonic is used as the name of the root of the 
release area for each platform or set of platforms. 

Loading the Software Distribution from CD

ClearQuest software is distributed on a ISO-9660 formatted CD (High Sierra, hsfs, 
cdfs). 

To copy the software from the CD to the computer that will serve as the networkwide 
release host:

1 Log on as root to a host with a CD drive. Ideally, this is the networkwide release 
host itself. But if that host does not have a CD drive, log on to a host that is 
NFS-accessible to the networkwide release host.

2 (If necessary) Create a mount point directory for the CD:

# mkdir /cdrom 

3 Place the ClearQuest CD in the drive. On Solaris hosts, the volume manager 
mounts the CD automatically, so you can skip to Step 5.

4 Mount the CD. For the mount command for your platform, see Table 9. 

Note that CD drive names vary from host to host. Thus, you may need to adjust 
the mount command in Step 5.

5 If the CD drive is not on the networkwide release host, use NFS facilities to export 
the CD drive’s mount point from its host, and mount it on the networkwide 

Table 9 Mnemonics and mount Commands

Architecture Mnemonic Sample mount command

Solaris SPARC sun5 Not necessary (if Volume Manager is in use)

HP-UX 11 hp11_pa 1

1. When installing ClearQuest on an individual host, you must use the appropriate release area for 
the architecture on your host. For example, if you have HP-UX 11 on your host, you must install 
from the hp11_pa release area.

mount -F cdfs -r /dev/dsk/c3d0s2/cdrom

AIX aix4_power mount –o ro –v cdrfs /dev/cd0 /cdrom

Red Hat Linux rhat_x86 mount –r /dev/cdrom /mnt/cdrom
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release host. For pathnames of the export command for each architecture, see 
Table 8. For example:

On the host with the CD drive:

# /usr/etc/exportfs –i –o ro /cdrom 

On the release host:

# mount drive-host:/cdrom /cdrom 

6 Log on as root to the networkwide release host. From the Bourne shell, run the 
script to load the ClearQuest software from the CD to the networkwide release 
host:

# cd /cdrom (most architectures) 
or

# cd /cdrom/rational (on Solaris)
# sh copy_rel.sh 

Running the site_prep Script

After the distribution has been loaded, run the site_prep script. site_prep is required to 
prepare the release area for installation of ClearQuest software on individual hosts. 
This script requires root user permissions and does the following:

■ Specifies the license server host

■ Specifies if there is e-mail notification

■ Establishes a default e-mail address if e-mail notification is enabled

■ Establishes ownership and sets permissions on all files in the release area

You must run site_prep for each architecture that your site supports. To guarantee 
access, log on to the release host as root. Change to the install subdirectory for the first 
supported architecture. For architecture mnemonics, see Table 9. 

For example: 

# cd /usr/clearquest_rls/v6.0
# cd sun5/clearquest/install
# ./site_prep 

If you specify no options, site_prep does the following:

■ Makes root owner of all files in the merged release area and disables writes to all 
files

■ Prompts you to provide this information: 

❑ Name of license server host
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❑ Whether e-mail notification will be enabled on clients

❑ When e-mail notification is enabled, the default e-mail address to send 
notification

The names you specify are supplied later as the defaults when install_release is 
run to install individual hosts.

Remember to run site_prep for any additional architectures your site supports. 

site_prep Options

Usage: site_prep [–enable_non_root | –disable_non_root] 
[–enable_email| –disable_email]
[–email_address email-notification-address]
[–license_host license-host-name |–lh license-host-name]
[–no_query | –nq] [–help] [–chmod]

Option Description

–enable_non_root Allows non-root users to install this 
release.

–disable_non_root Reverts to allowing only root users to 
install this release.

–enable_email Enable e-mail notification. After e-mail is 
enabled, an e-mail notification address 
must be specified.

–disable_email Disables e-mail.

–email_address 
email-notification-address

Specifies a default e-mail address to send 
notification.

–license_host license-host-name Specifies location of license host.

–no_query If values are not specified using the command 
line: sets license host to Unknown; leaves the 
setuid mount options for install hosts 
unchanged; suppresses querying for other 
values not set in the command line.

–help Displays this summary of site_prep 
options.

–chmod Disables write access to release area files 
and directories.
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Allowing Non-root Users to Install ClearQuest

To allow ClearQuest installation without becoming root user use the 
–enable_non_root option. This is always done as a separate invocation of site_prep. To 
do so:

# site_prep –enable_non_root 

If you have enabled non-root installation, enter the following command after all 
ClearQuest hosts have been installed to eliminate the possibility of a security breach. 
(This is always done as a separate invocation of site_prep.) Rational has taken care to 
minimize the security risks of a non-root ClearQuest installation, but this step provides 
extra assurance. To do so:

# site_prep –disable_non_root 

Specifying Regionwide Product Resources

If you do not specify the name of your license host in the site_prep command line, you 
are prompted to enter it. The –no_query option suppresses the query, but sets the 
values as specified in the command line. If this name is not specified, –no_query sets 
its value to Unknown. 

When you install ClearQuest on individual hosts (for supported platforms, see System 
Requirements on page 7), this location is offered as the default. (If your network has 
several license server hosts, some or all users must override the default.)

Setting Protections on Files in the Release Area

If you did not load the distribution as root, the directories may have been created with 
write access enabled. The –chmod option corrects the write-protection problem.

Verifying site_prep Selections

The site_prep script creates or edits a text file named site.dat under the /clearquest 
directory in each architecture-specific directory of the release area for which site_prep 
is run. For the example release area and scenario mentioned in Running the site_prep 
Script on page 51, the directory is /usr/clearquest_rls/v6.0/sun5/clearquest. 

For each architecture that your site supports, examine site.dat to verify that there are no 
typographical errors in the information provided to site_prep. If the information is 
incorrect, rerun site_prep for that architecture. 
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Ensuring That the Release Area Is Accessible to All Hosts

Make sure that the exported directory on the release host, for example 
/usr/clearquest_rls, is accessible to all client hosts. For details, see Table 8 on using the 
export command. 

Publicizing the Location of the Release Area

To install ClearQuest on their own client hosts, users need the pathname for the 
ClearQuest release area.

Proceed to Install Individual Hosts

The setup of the networkwide release host is now complete. You have not installed any 
ClearQuest product on this host; you have only loaded the software there and set some 
default values to be used by the install_release program, which installs ClearQuest on 
individual hosts.

You can now install ClearQuest around the network yourself or allow users to perform 
their own installations. Installation on individual hosts is the subject of Chapter 5, 
Installing ClearQuest on Individual Hosts.
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5Installing ClearQuest 
on Individual Hosts
This chapter presents both background information and detailed instructions for 
installing Rational ClearQuest on individual hosts. 

The install_release program handles the ClearQuest installation on UNIX. 
install_release separates the choice of how the software is installed on the local 
system—called the installation model and method—from the choice of ClearQuest 
product options being installed. 

Note: ClearQuest documentation uses cquest-home-dir. The default ClearQuest 
installation directory is /opt/rational/clearquest. Substitute your own local installation 
directory for cquest-home-dir, whenever you encounter it. If you choose to install to a 
directory that is different from the default, you cannot install to a directory named 
/usr/atria/clearquest.

Client Hosts

This section explains installation issues for client hosts.

ClearQuest Considerations
■ To configure the ClearQuest schema repository and user databases, you must first 

install ClearQuest Administration Tools on a Windows host. 

■ Using the ClearQuest installation for individual hosts, you can perform a UNIX 
client installation.

If your ClearQuest database is Oracle on Solaris or HP-UX or AIX or Red Hat Linux, 
you must install the OpenLink Broker on the database host and an Oracle client on the 
ClearQuest administrator host. For more information, see Installing OpenLink Request 
Broker with Oracle on page 75 and Creating an Oracle Database Alias on page 66.

If your ClearQuest database is DB2 on Windows or AIX or Red Hat Linux, for database 
connectivity you must install the DB2 client on the administrator host and on native 
clients. For more information, see Creating a DB2 Database Alias on page 65 and 
Configuring a Database Alias to Connect Native Clients to a DB2 Database on page 71.
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Client Hosts

Your network may include a large number of potential ClearQuest client hosts. You can 
allow users to run install_release themselves; they may not need root privileges to run 
the program (see Allowing Non-root Users to Install ClearQuest on page 53). 

Selection Criteria

ClearQuest client programs make considerable demands on a host’s processing power 
and memory. The most successful approach is to have each developer use their own 
computer, which must meet or exceed the performance characteristics described in 
System Requirements on page 7.

Several users can share a client host (for example, by using X terminals) if the host can 
provide appropriate multiples of these single-user performance specifications—both 
processing power and memory.

Defining the Network Location of the Client Host

The install_release program needs to know the NFS mount point for your 
environment to install successfully.

install_release will first check for the environmental variable NFS_MNT. If this variable 
is set, install_release accepts its value as your NFS mount point.

If this variable is not set, install_release tries the NFS mount point net, then nfs, then 
hosts, to determine the NFS mount point.

Therefore, if the mount point used in your environment is not /net, /nfs, or /hosts, you 
must set NFS_MNT to allow successful installation.

For example, if your NFS mount point is /accts, you must set NFS_MNT to accts with 
the following command:

setenv NFS_MNT accts 

Note: This command assumes C shell.

Maintenance Requirements

A client host requires no maintenance specific to ClearQuest. 

Operating System Patches

ClearQuest installation interacts with a host’s operating system at a lower level than 
many other applications do. Accordingly, ClearQuest installation may be more 
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sensitive to OS-level bugs, particularly kernel bugs. Rational works closely with 
hardware vendors to maintain a current list of required and recommended operating 
system patches. This list is available in the Release Notes. Such patches are available 
from your hardware or OS vendor. Before installing ClearQuest, obtain and install the 
appropriate operating system patches.

Installation Methods and Models

When you invoke install_release, you are presented with the following installation 
methods:

■ Select Local Install to install software on the local system (the one you are 
currently logged on to).

■ Select Local Deinstall to remove software from the local system.

After you select the installation method, install_release prompts you to select an 
installation model: 

■ Standard — Regular installation, with links to the release area
■ Full-Copy — Regular installation, with no links to the release area

The model you select is used for all selected components in a given invocation of 
install_release. You may want to review the models and their characteristics before 
running install_release for the first time.

Your choice of model determines whether the contents of cquest-home-dir are files or a 
combination of files and links to the release area). In choosing the model, you need to 
consider the amount of available storage and the expected patterns of use for the target 
computer:

■ Is the computer a database server or a client or both? 
■ Does it need to operate even when the network release area is unavailable? 
■ Does it have adequate local disk space for the ClearQuest installation? 
■ Is cquest-home-dir on a read-only partition?

You may also want to consider the administrative advantages of one installation model 
over another:

■ The Standard installation model is designed to be the best combination of features, 
reliability, performance, and disk space use.

■ The Full installation model copies all of the software from the release area to the 
local host. It has no dependence on the network, but requires a large amount of 
disk space. 
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The Standard Installation Model

The Standard installation model creates cquest-home-dir on the target system as a 
directory and populates it with a combination of locally installed files and links to the 
release area. All shared libraries and critical executables are copied to the target system. 
Other files, such as Help and various nonessential scripts and utilities, are installed as 
links to the release area. Systems installed by using the Standard model perform all 
necessary ClearQuest functions as long as the necessary ClearQuest databases and the 
license server hosts are accessible. There is no significant performance penalty 
associated with the Standard installation model, and it consumes significantly less 
disk space than the Full-Copy model.

We recommend the Standard installation model for any client with adequate disk 
space that does not have to operate when disconnected from the network.

The Full-Copy Installation Model

The Full-Copy installation model creates cquest-home-dir directory on the target system 
and populates it completely with files. Systems installed by using this model perform 
all ClearQuest functions as long as the necessary ClearQuest databases and the license 
server hosts are accessible.

We recommend the Full-Copy installation model for any client with adequate disk 
space that does have to operate when disconnected from the network.

The Deinstallation Model

The Local Deinstall method provides you with a list of currently installed products 
and components to remove from the local system. All installed products or 
components can be deinstalled. Selecting a component for deinstallation also causes 
any other components that depend on that component to be deinstalled at the same 
time. After all the selections have been made, you are prompted to finish the deinstall.

Local Deinstall preserves the ClearQuest database registry directories located at 
/opt/rational/clearquest/CQDB_rgys in /var/tmp/Rational.preserve. 

Compatibility Between Models

If you want to change from one installation model to any other, it is recommended that 
you deinstall your currently installed products before you install with the new model. 

Note: The installation script warns you if you attempt to change models when 
installing new software.
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Order of Installation

We recommend that you deinstall any previously installed products before you install 
the new release. Deinstalling cleans up obsolete links and files.

It is important to install hosts in this order:

1 License server host, on which important site information is stored. (For more 
information, see Chapter 3, Configuring ClearQuest Licensing.)

2 ClearQuest client hosts on UNIX, on which users run ClearQuest client programs. 

Selecting the Products for Installation

install_release presents a list of products that you can install. This list is based on the 
contents of the networkwide release area from which install_release is being run and 
can include any ClearQuest product option for UNIX. In addition, you can make any 
of the following procedural selections:

Select each product, one at a time, by typing its number. install_release responds by 
displaying the list with an asterisk to the left of each selected product. 

Note:  You can select products by entering multiple numbers separated by spaces. For 
example, you can enter the following on a single line:

1 f 

Selection and name Description

x Toggle expanded 
descriptions 

Alternates display of list of products with 
descriptions and list of products without 
descriptions. By default, product descriptions 
are not displayed.

a Select all Selects all listed components. 

f Finish selection Indicates that you have selected everything you 
want to install/deinstall and are ready to 
complete the installation/deinstallation. 

r Reset selections Clears everything. 

q Quit Quits install_release. 
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Running the Installation Script 

After you make all the preparatory selections, the host is ready for ClearQuest 
installation.

Before you begin performing installations:

■ Verify that the ClearQuest release area is visible from every host to be installed. 
This is typically done through NFS mounts, symbolic links, or both. 

■ Verify that each host has adequate disk space for the installation. See System 
Requirements on page 7.

After the site_prep script runs, default values for most install_release pathname and 
host name options are established. If you are not going to use the default choices that 
site_prep supplies to install_release, make sure you have the following information 
before you run install_release:

■ The name of your license server host
■ If e-mail notification is enabled, the default e-mail address to receive notifications

Note: The following examples use the number sign (#) as the shell prompt; this is the 
standard prompt for the root user. The examples also assume use of the C shell for 
commands that set environment variables.

Invoking install_release

To invoke and run install_release: 

1 Log on to the host to be installed. If non-root installation has been enabled at your 
site (see Allowing Non-root Users to Install ClearQuest on page 53), you can log on as 
a nonprivileged user. Otherwise, you must log on as root user. 

Note: If the site_prep script was not run on the release area, install_release aborts. 
In addition, before running install_release on RedHat Linux platforms, you must 
set the TZ environment variable. For more information, see Setting the TZ 
Environment Variable on Red Hat Linux on page 80.

2 Go to the install subdirectory within the networkwide release area for the 
appropriate architecture:

For architecture mnemonics, see Architecture Mnemonics and mount Commands on 
page 50.

# cd 
/net/bigserver/usr/clearquest_rls/v6.0 

(typical release area) 

# cd sun5/clearquest/install (architecture-specific location within release area) 
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3 Invoke the install_release program:

# ./install_release 

After a series of legal notices, you see the list of ClearQuest product options that 
can be installed from this release area. In addition, you are informed of both the 
temporary and permanent locations of a log file of your installation. The log file 
includes everything you see during the installation and the results of your actions. 

If the installation completes without generating informational messages, the log 
file in /tmp is deleted. If the installation fails, the log file is preserved in /tmp. If the 
installation completes, but generates error or informational messages, the log file is 
placed in /var/adm/rational/clearquest/log/Rational_install.time-stamp.

You can type q at any prompt to quit the installation. 

4 Choose your installation method (Local Install or Local Deinstall).

5 The Rational license agreement and the third-party license agreements are 
displayed if you have selected the Local Install installation method. When 
prompted to accept the terms of each of these license agreements, type y to 
continue with the installation.

6 Choose your installation model. All products installed in this session use the 
model you choose. Selecting the Standard model results in an optimal trade-off 
between reliability and performance.

7 Specify the directory on the local host in which to place the products that you plan 
to install. 

Note: The directory location cannot be a networkwide release path. For example 
/net/machine-name/opt/rational/clearquest is not a supported install location.

Unless you have been instructed otherwise, we recommend that you take the 
supplied defaults [listed in square brackets] on all such prompts. Take the default 
by pressing RETURN. 

8 Name the location of the networkwide release area. This is where any files or 
directories installed as symbolic links actually reside.

9 Now you are presented with a list, including ClearQuest, as the installation 
options. 

1 : ClearQuest

a : Select all

f : Finish selection

x : Toggle expanded descriptions

r : Reset selections

q : Quit
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Select ClearQuest by number. To select the entire list, enter a for all. If you change 
your mind, enter r for reset. If you need more information, enter x to expand the 
component descriptions. When you have chosen all the products you want to 
install, enter f to indicate that you are finished making selections.

10 After you enter f, install_release displays a complete list of all the components you 
selected for installation. Note that some of these components were not on the list of 
selectable items. This list appears primarily so that it can be recorded in the install 
log file. The components are then installed one at a time.

Unless you have been instructed otherwise, accept the defaults [in square brackets] 
by pressing RETURN at the prompt. The defaults on your system will the default 
values defined using site_prep. (See Running the site_prep Script on page 51 to see 
where these default names come from.) For example:

Rational License Server Host[neon]:

Enable email notification (yes, no, quit) [yes]

Default e-mail address [foo@someplace.com]

After all the questions have been answered, install_release has the information 
needed to perform the installations you have requested, as stated in the on-screen 
information. 

**** Enter ‘quit’ or ‘no’ to abort the installation ****

**** Enter ‘yes’ or press <RETURN> to continue ****

Continue installation?(yes, no, quit)[yes]:

At this point, you must decide whether to go ahead with the installation. Until now, 
there has been no modification of the system (other than creating the log file). No files 
have been moved, and no processes have been affected.

The installation then prompts you for the directory name of the ClearQuest database 
registry directory.

The interactive portion of the installation is complete.
If you choose to continue, the previously listed components 
will be installed/updated. 

Upon completion, the installation status will indicate whether
there were problems, and provide reminders of post-installation
steps.

This WILL NOT include stopping all currently running ClearQuest 
Product Family software.
This WILL NOT require a reboot of the system.
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Note: If you are reinstalling after a deinstall, the directory (CQDB_rgy) holding the 
ClearQuest database registry directory (or directories) is automatically moved from 
/var/tmp/Rational.preserve back to /opt/rational/clearquest. 

ClearQuest Client/Server - Database Registry Menu

NOTE: The directory CQDB_rgys has been moved from 
/var/tmp/Rational.preserve back to /opt/rational/clearquest.

Please enter the ClearQuest database registry directory to use/reuse.

NOTE: For your ClearQuest database registry directory, you may

specify an absolute path to a location outside the install area,

or you may specify an absolute path to (or a relative path under) the

designated default location /opt/rational/clearquest/CQDB_rgys.

The designated default location is the only allowable location

within the install region for establishing ClearQuest database

registry directories.

ClearQuest database registry directories created under the

designated default location will be preserved upon deinstall,

and reinstated upon reinstall.

For ClearQuest database registry directories specified in either

the designated default location or outside the install area,

the following is true:

If the specified ClearQuest database registry directory does not

currently exist, the installer program will attempt to create it

along with any other nonexisting directories specified in the path.

Full read, write, and execute permissions on the ClearQuest

database registry will then be established by the installer program.

If the specified ClearQuest database registry directory already

exists, the installer program will require that it have full read

and execute permissions for the installation to complete successfully.

Invoking ClearQuest requires access to the ClearQuest database 
registry directory.

Therefore, if you plan to invoke ClearQuest from any other machines, 
you must provide a network accessible path.

Note: For example, if you are installing on a machine named xxx and you plan on 
invoking ClearQuest on client machines named yyy and zzz, during installation you 
are prompted for the ClearQuest Database registry directory. You may decide to take 
the default location /opt/rational/clearquest/CQDB_rgys/cqdb_registry. Although this 
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location is on machine xxx, machines yyy and zzz will also need to access this location. 
Therefore, you must provide a network accessible path for this location. You would 
enter (assuming /net is your NFS mount directory): 
/net/xxx/opt/rational/clearquest/CQDB_rgys/cqdb_registry. When ClearQuest is invoked on 
machines yyy and zzz, they will be able to access the registry location on machine xxx.

If the directory you specify does not exist, the installation prompts you to create it:

/opt/rational/clearquest/CQDB_rgys/cqdb_registry not found

Create it? (yes, no, quit, help) [yes]

The installation then displays the following message:

Before running ClearQuest, you must source using one of the provided 
cq_setup scripts.  If you are installing this for users in addition to 
yourself you must have them add one of these commands to their login 
environment.

    Users of csh, tcsh and other csh-compatible shells do this:

    source /opt/rational/clearquest/cq_setup.csh

    Users of sh, ksh, bash and other bourne-compatible shells do this:

    . /opt/rational/clearquest/cq_setup.sh

After the installation is finished, read all messages displayed carefully. In particular, 
look for errors that may have occurred during installation. If there is a problem, look 
in the installation transcript log (/var/adm/rational/clearquest/Rational_install.time-stamp) 
for information about how to correct the errors. If you are unsure how to proceed, call 
Rational Customer Support.

Note: If the installation was aborted, the installation log may be in /tmp. 

MultiSite Shipping Configuration Files

If you are upgrading from a previous release of Rational ClearQuest MultiSite and 
install_release detects the existence of a previously installed shipping.conf, it generates a 

message to the user that a merge may be required.

The template file is ccase-home-dir/config/services/shipping.conf.template and the current 
configuration file is /var/adm/rational/clearcase/config/shipping.conf.
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6Postinstallation and 
Administration
This chapter describes postinstallation configuration procedures and provides some 
information about administering Rational ClearQuest. 

To complete the installation, you must configure the ClearQuest databases using the 
administration host and then connect to the database using a native client.

Create Database Aliases for Oracle or DB2

You must create database aliases to access an Oracle or a DB2 database. To do so, you 
must use the DB2 client software to create a database alias on the ClearQuest 
administrator host. For DB2, you must create the database alias on all native client 
hosts also.

For Oracle, you must use Oracle client software to create a database alias on the 
ClearQuest administrator host.

When creating the database alias for either Oracle or DB2, the database alias name 
must be identical on all hosts that use it. For example, if the DB2 database alias cqdb is 
created on the ClearQuest administrator host, all native client hosts must create the 
DB2 database alias cqdb.

Creating a DB2 Database Alias

To configure access to a DB2 database server host for the ClearQuest administrator 
host, you must use the DB2 Client Configuration Assistant to create an alias for each 
physical ClearQuest database.

1 For DB2 7.x, click Start > IBM DB2 > Client Configuration Assistant. For DB2 8.1, 
click Start > IBM DB2 > Set-up Tools > Configuration Assistant.

2 For DB2 7.x, in the Welcome dialog box, click Add database. For DB2 8.1, in the DB2 
Message dialog box, click Yes. Then, click Search the network and click Next.

3 Expand the Known Systems folder. If you see the database server host on which the 
ClearQuest database resides, expand it and select the database name for which 
you want to create an alias. Click Next.
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Note: If you do not see the database server host you need, expand the Other 
Systems folder. If you still do not see the host, talk to your ClearQuest database 
administrator. There may be a network problem.

4 Type an alias name in the Database alias box. Type an optional comment in the 
Comment box and click Next.

5 Clear the Register this database for ODBC option, if it is selected. Click Finish.

6 A confirmation dialog box opens. To test access to the database, click Test 
Connection and type the user name in the User ID box and password in the 
Password box.

If the connection fails, attempt to connect by using the following command:

db2

db2> catalog TCPIP node node-name remote host-name server port-number

db2> catalog database database-alias at node node-name

db2> terminate

Note: When the administrator configures the connection to the DB2 database 
server, the database alias is entered in the Database Alias box on the Maintenance 
Tool. For more information about using the Maintenance Tool, see Creating a 
Schema Repository on page 67 and Creating a User Database on page 69.

Creating an Oracle Database Alias

To configure a ClearQuest administrator’s host for access to an Oracle database, you 
must use the Net8 Assistant program to create an alias for each physical ClearQuest 
database.

1 Click Start > Oracle - OraHome81 > Network Administration > Net8 Assistant.

2 In the navigation pane, expand Net8 Configuration, click Local, and then select 
Service Naming.

3 Click Edit > Create and complete the New Name Service Wizard:

a Type the name of the alias in the Net Service Name box. Click Next.

b Click TCP/IP to select the network protocol to use to communicate with the 
database. Click Next.

c Type the name of database server host in the Host Name box and type the port 
number in the Port Number box.
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d Type the service name in the Service Name box and select the Oracle8i 
Connection Type. Click Next and then click Test. If the test of the connection 
succeeds, click Finish.

Note: When the administrator configures the connection to the Oracle database 
server, the Net Service Name is entered in the SQL*Net Alias box on the 
Maintenance Tool. For more information about using the Maintenance Tool, see 
Creating a Schema Repository on page 67 and Creating a User Database on page 69.

Creating the ClearQuest Databases

After you install ClearQuest and create the necessary empty vendor databases, you 
must create the schema repository and the user databases. Initially, you can create a 
sample user database to learn more about the product. You can create your user 
databases later. For more information about configuring an evaluation database, see 
the Installation Guide for Rational Server Products.

Creating a Schema Repository

To create a new schema repository:

1 Click Start > Programs > Rational Software > Rational ClearQuest > ClearQuest 
Maintenance Tool.

2 Click Schema Repository > Create.

3 In the Existing Connections area, type a name for the schema repository 
connection, and press ENTER.

4 In the Schema Repository Properties area, select a vendor database from the Vendor 
list and type the full path for the database in the Physical Database Name box. Click 
Next. 

Then enter the information required for your vendor database.

For SQL_SERVER

a Type the database name for SQL Server schema repository in the Physical 
Database Name box.

b Type the name of the database server in the Database Server Name box.

Note: Each native client must be able to access this server host by using the name 
exactly as it appears in this entry.

c Type the database owner (DBO or Administrator) user name in the 
Administrator Name box.
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d Type the password for the database owner (DBO or Administrator) in the 
Administrator Password box.

e Type the general purpose or read/write user name in the Read/Write User Name 
box.

f Type the password for the general purpose or read/write username in the 
Read/Write User Password box.

g Type the schema repository or read-only user name in the Read-Only User Name 
box.

h Type the password for the schema repository or read-only user name in the 
Read-Only User Password box.

For ORACLE

a Type the TNS name (SQL*Net Alias pointing to the Oracle instance) in the 
SQL*Net Alias box.

b Type the user name you created for the schema respository in the User Name 
box.

c Type the password for the user name in the Password box.

d Specify the following options in the Connect Options box, separated by 
semicolons. For example: 

Host=name; SID=name; Server_ver=8.1; Client_ver=8.1;
Lob_type=LONG or CLOB

Option Definition

Host The name of the database server host. If your ClearQuest 
environment includes UNIX and Windows clients, this name 
is mandatory.

SID The name of the database instance. If your ClearQuest 
environment includes UNIX and Windows clients, this name 
is mandatory.
On UNIX, the SID is case-sensitive.

SERVER_VER The version of the Oracle server you are using. (For Oracle 8i, 
use 8.1.)

CLIENT_VER The version of the Oracle client software you are using. (For 
Oracle 8i, use 8.1.)
If ClearQuest users want to use a different Oracle client 
version than what is entered here, they must override the set 
options manually. The default setting is 8.1.
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Note: All ClearQuest UNIX client users must use the same Alias or Net Service 
Name (TNSname), Database Instance (system ID or SID), TCP/IP protocol, and 
Host Name (Oracle server host).

For DB2

a Type the database alias name (alias pointing to the DB2 database) in the 
Database Alias box.

b Type the user name created for the schema repository in the User Name box.

c Type the password for the user name in the Password box.

5 Click Next.

6 In the schema definition area:

a (Optional) Select the Create sample database option.

b In the Schema to use list, select the schema to use. For information about the 
schema options, see the Administrator’s Guide for Rational ClearQuest.

c In the Database Name box, type the database name for the schema repository.

d In the Description box, type a description.

7 (Optional) If the Create sample database option was selected, in the Sample User 
Database area, enter the properties of the database designated for the sample 
database. 

8 Click Finish. In the Status dialog box, verify the successful creation of the schema 
repository.

Creating a User Database

After you create a schema repository, you can create ClearQuest user databases.

1 Click Start > Programs > Rational Software > Rational ClearQuest > ClearQuest 
Designer.

2 In the Schema Repository dialog box, select the schema repository to use for 
creating a user database.

3 In the ClearQuest Designer Login dialog box, log on with the default ClearQuest 
administrator login name and password. The default user name is admin; the 

LOB_TYPE The type of data you are using. The valid data type is LONG or 
CLOB. 

Option Definition
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password is Null and should be left blank. You can change this password and 
create a new login at your earliest convenience. Click OK.

4 When the Open Schema dialog box opens, click Cancel.

5 Click Database > New Database.

6 Type a logical database name in the Logical Database Name box for the user 
database you want to create. This name can be up to five characters. Click Next.

7 Select the vendor database you plan to use and type the properties appropriate for 
that vendor. (For more information, see Creating a Schema Repository on page 67.) 
Then, click Production Database or Test Database. Click Next.

8 Click Next to accept the default Timeout and Poll Interval polling parameters.

9 Select a schema with which to associate your user database.

10 Click Finish.

Setting Up the ASCII Code Page 

To ensure data integrity for UNIX clients that write data to the ClearQuest database, 
you must set the code page to ASCII in three places:

1 On the administrator host, run installutil to set the schema repository code page to 
ASCII. For more information, see the Administrator’s Guide for Rational 
ClearQuest.

2 Run the database management tool for your ClearQuest database and set the 
database code page to ASCII. For more information, see the Administrator’s Guide 
for Rational ClearQuest.

3 If you are using an Oracle or SQL Server database for ClearQuest, when installing 
OpenLink Broker software on the Oracle server host or the SQL Server host, you 
must set up the OpenLink Broker for an ASCII code page. For more information, 
see Installing OpenLink Request Broker with Oracle on page 75 and Installing 
OpenLink Request Broker with SQL Server on page 73.

Configuring the ClearQuest Client

To configure native clients to log on to the ClearQuest database, perform the 
appropriate procedure.
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To Access a DB2 Database

1 If necessary, create a database alias on each native client. See Configuring a Database 
Alias to Connect Native Clients to a DB2 Database on page 71.

2 Set up the login environment on the native clients. See Customizing the Client Host 
Environment on page 79.

3 Log in and register the ClearQuest database. See Logging In to the Client on page 80.

To Access a SQL Server Database

1 If necessary, install OpenLink Broker on the SQL Server server host. See Installing 
OpenLink Request Broker with SQL Server on page 73.

2 Set up the login environment on the native clients. See Customizing the Client Host 
Environment on page 79.

3 Log in and register the ClearQuest database. See Logging In to the Client on page 80.

To Access an Oracle ClearQuest Database

1 If necessary, install OpenLink Broker on the Oracle database server host. See 
Installing OpenLink Request Broker with Oracle on page 75.

2 If necessary, configure ODBC catalog view for the Oracle database. See Installing 
the OpenLink ODBC Catalog Views for Oracle 8 on page 76.

3 Create a startup script for an Oracle database on Solaris and HP-UX. See 
Automating Startup on Reboot for an Oracle Database Server on Solaris on page 77 and 
Automating Startup on Reboot for an Oracle Database Server on HP-UX on page 77.

4 Set up the login environment on the native clients. See Customizing the Client Host 
Environment on page 79.

5 Log in and register the ClearQuest database. See Logging In to the Client on page 80.

Configuring a Database Alias to Connect Native Clients to a DB2 
Database

For a native client to access a DB2 database, the DB2 client software must be installed 
on each native client host. For installation information, see the IBM DB2 product 
documentation. 

After the DB2 client software is installed on the native client host, perform the 
following steps:
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1 Log on to the native client host as a user with privileges to modify the database 
instance (perhaps the UNIX user who created the DB2 instance).

2 Use the source command to set up the DB2 environment:

❑ For csh, tcsh, and other csh-compatible shells:

source ~DB2-instance-user/sqllib/db2/cshrc 

❑ For sh, ksh, bash and other Bourne-compatible shells:

. ~DB2-instance-user/sqllib/db2profile

The DB2 ODBC driver requires that this environment be set for all operations; 
ClearQuest does not operate properly with DB2 if this environment is not set. A 
typical symptom that the environment is not set is that the DB2 ODBC driver will 
be unable to log on to the DB2 database.

3 Run the DB2 command line administration tool, db2.

4 Create a DB2 TCP/IP Node for use by the native client. The node alias must be the 
same for all DB2 clients. The port number is the TCP/IP port used by the DB2 
service. 

db2> CATALOG TCPIP NODE node-alias REMOTE server-host-name SERVER 
port-number

5 Create a DB2 database alias for each physical database. The database alias must be 
the same for all DB2 clients.

db2> CATALOG DATABASE database-name AS database-alias AT NODE node- 
alias

6 Test the connection to the DB2 database. The CONNECT command should 
succeed.

db2> CONNECT TO database-alias USER database-user-id USING password

db2> DISCONNECT CURRENT

db2> QUIT

7 Create a symbolic link from the ClearQuest install area to the installation area for 
the DB2 ODBC device driver. This link is required because ClearQuest does not 
distribute the DB2 device driver. A typical symptom that this step was omitted is 
that ClearQuest indicates that the specified driver could not be loaded while 
attempting to log on to the DB2 database. (This step must be completed for every 
native client install area that will access DB2.)

cd cquest-home-dir

cd arch/shlib

ln -fs IBM DB2 Install Dir/DB2 version/lib/libdb2.so db_IBMDB2
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For AIX only:

ln -fs IBM DB2 Install Dir/DB2 version/lib/db2.o db_IBMDB2

Note: When using a DB2 8.1 client on AIX, you will need to create an object file for 
the ODBC driver manager load (if it does not exist) prior to connecting to DB2. To 
create db2.o on AIX, extract the shared library from the ODBC driver for DB2:

cd IBM DB2 Install Dir/DB2 version/lib

ar -x libdb2.a

Then, create the db2.o file: 

mv shr.o db2.o

8 Repeat Step 5 and Step 6 for each physical database.

9 Register the ClearQuest database at a native client login (see Logging In to the Client 
on page 80.) The following information is required to successfully connect:

❑ Vendor: DB2

❑ Server: server host name

❑ Database: database alias for schema repository

❑ User Name: database-user-id

❑ Password: password

Installing OpenLink Request Broker with SQL Server

To run SQL Server databases on a Windows host, you must install the OpenLink 
Request Broker on the SQL Server host. The OpenLink Request Broker software is 
provided on the ClearQuest Installation CD.

1 Create an openlink-home directory on the SQL Server host for the OpenLink Broker 
installation.

2 From the networkwide ClearQuest release area, copy 
release-area/clearquest/openlink-server/windows to the openlink-home directory on the 
SQL Server host.

3 From the openlink-home directory on the SQL Server host, run opl.exe. This is a 
self-extracting .zip file whose default directory location is C:\Program Files\OpenLink. 
Click Browse to change this location.

4 Execute this command:

cqperl oplrqb.pl
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5 When prompted for the directory to which you extracted the data, type the 
directory path and press ENTER. The request broker will be installed, and the 
oplrqb service will be registered. No other server configuration is necessary.

6 Connect to the SQL Server host from the native client as you would the Windows 
client. When registering the ClearQuest database (see Logging In to the Client on 
page 80) at the native client logon, the following information is required to 
successfully connect:

❑ Vendor: SQLSERVER

❑ Server: server hostname

❑ Database: database name for schema repository

❑ User Name: SQL Server user name created for schema repository

❑ Password: SQL Server password created for schema repository

Note: The SQL Server host name that you enter must be accessible from all native 
client hosts. When in doubt, use the ping command to verify connectivity.

Using OpenLink Broker for ASCII Mode

For SQL Server, you do not have to explicitly configure OpenLink Broker to use the 
ASCII code page. However, during the SQL Server installation, the administrator must 
configure a default collation. 

For SQL Server 7, during the installation, configure the default collation in the 
Character Set/Sort Order/Unicode Collation dialog box:

1 Click the Character Set box and select 1252/ISO Character set (Default).

2 Click the Sort order box and select Binary order.

3 Click the Locale Identifier box and select Binary order.

4 Specify case-sensitivity; select the Case-insensitive check box to select either 
case-sensitive or case-insensitive.

For SQL Server 2000, during the installation, configure the default collation in the 
Collation Setting dialog box:

1 In the Collation designator list, select Latin1_General.

2 Under Sort order, click the Binary option.

When these values are specified as the default collation for SQL Server, OpenLink 
Broker handles all data as ASCII.
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Installing OpenLink Request Broker with Oracle

After setting up an Oracle database server, (see Chapter 2), you must also install 
OpenLink Request Broker on the Oracle database server to facilitate database 
connections. 

Note: The OpenLink Request Broker software can be installed on the UNIX file 
server if that file server is NFS mountable by the database server. But, it must 
execute locally on the database server.

1 Create an openlink-home directory on the Oracle server for the OpenLink Broker 
installation.

2 From a ClearQuest release area, copy release-area/clearquest/openlink-server/arch/ to 
the openlink-home directory on the Oracle server.

where

3 Log on to the Oracle server as the user ID that you will use to install ClearQuest. 

4 Change to the directory where OpenLink Broker is installed.

cd openlink-home

5 Run the installation script:

sh install.sh 

When prompted for the installation information, accept any default values that are 
provided.

6 After the installation script is complete, run post_install.sh to configure your 
Oracle settings:

sh post_install.sh 

7 The post_install shell prompts you to enter the values for your Oracle root 
directory (ORACLE_HOME) and your Oracle system ID (ORACLE_SID). 

Note: You may rerun this script to reset the options at any time.

8 The configuration process is complete. Type Quit to quit the OpenLink 
Configuration Utility. 

arch Hardware system. Use one of the following values:
■ hp1100
■ sun5
■ aix4_power
■ rhat_x86
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Setting Up OpenLink Broker for ASCII Mode

1 On the Oracle server host, open openlink-home/openlink_server/arch/bin/oplrqb.ini in a 
text editor and locate the [Environment ORACLE81] section.

2 Add the following lines to the end of that section:

NLS_LANG=AMERICAN_AMERICA.US7ASCII

NLS_NUMERIC_CHARACTERS=.,

NLS_SORT=binary

NLS_DATE_FORMAT=DD-MON-YY

3 Save the file and exit the text editor.

Updating the OpenLink Broker Driver for an Oracle Database 
Server on Solaris

When using Oracle 8.1.6 or 8.1.7 with Solaris, you must update the OpenLink Broker 
driver after installing OpenLink Broker. To update OpenLink Broker:

1 From the openlink-home/bin directory on the Oracle server, create a backup copy of 
ora81_mv.

2 From a ClearQuest networkwide release area, copy 
release-area/clearquest/openlink-server/sun5/ora81_mv.42_sol28_Oracle8.1.7 to the 
openlink-home/bin directory on the Oracle server as ora81_mv.

Installing the OpenLink ODBC Catalog Views for Oracle 8 

On the Oracle server host, run svrmgrl with the corresponding SQL script, and use 
odbccat8.sql for Oracle 8. The script is located in the newly created bin directory. 

1 Log on as the Oracle database administrator.

2 Change to the directory that contains the odbccat8.sql script: 

cd openlink-home/openlink_server/arch/scripts/Oracle

where

arch Hardware system. Use one of the following values:
■ hp1100
■ sun5
■ aix4_power
■ rhat_x86
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3 Enter the following commands. Note that the command svrmgrl lmode uses the 
letter l, not the number 1.

> svrmgrl lmode=y
SVRMGR> @odbccat8.sql
SVRMGR> EXIT

For more information, see the comments in the odbccat8.sql file.

Automating Startup on Reboot for an Oracle Database Server on 
Solaris

The following instructions assume that your UNIX installation uses the typical 
directories for startup and shutdown scripts. To restart the OpenLink Request Broker 
after rebooting the Oracle database server:

1 Log on as root.

cd openlink-home/openlink_server/sun5

2 Copy the script rc.OpenLinkBroker script to the /etc/init.d directory. 

cp rc.OpenLinkBroker /etc/init.d/openlinkbroker

3 Edit the script to change the value of BIN_DIR to

openlink-home/openlink_server/sun5/bin

4 Make the script executable: 

chmod +x /etc/init.d/openlinkbroker

5 Create symbolic links for startup and shutdown. Note that the example uses 98 for 
startup and 02 for shutdown. You may need to use different numbers so that the 
startup script is invoked after any Oracle and NFS startup scripts.

>ln -s /etc/init.d/openlinkbroker /etc/rc2.d/S98openlinkbroker

>ln -s /etc/init.d/openlinkbroker /etc/rc2.d/K02openlinkbroker

Automating Startup on Reboot for an Oracle Database Server on 
HP-UX

The following instructions assume that your UNIX installation uses the typical 
directories for startup and shutdown scripts. To restart the OpenLink Request Broker 
after rebooting the Oracle database server:

1 Log on as root. 

cd openlink-home/openlink_server/hp1100

2 Copy the script rc.OpenLinkBroker script to the /sbin/init.d/ directory. 
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cp rc.OpenLinkBroker /sbin/init.d/openlinkbroker 

3 Edit the /sbin/init.d/openlinkbroker script to change the value of BIN_DIR to be: 

openlink-home/openlink_server/hp1100/bin

4 Make the script executable.

chmod +x /sbin/init.d/openlinkbroker 

5 Create symbolic links for startup and shutdown. Note that the example uses 98 for 
startup and 02 for shutdown. You may need to use different numbers so that the 
startup script is invoked after any Oracle and NFS start up scripts.

>ln -s /sbin/init.d/openlinkbroker /sbin/rc2.d/S98openlinkbroker

>ln -s /sbin/init.d/openlinkbroker /sbin/rc2.d/K02openlinkbroker

Automating Startup on Reboot for an Oracle Database Server on 
AIX

The following instructions assume that your UNIX installation uses the typical 
directories for startup and shutdown scripts. To restart the OpenLink Request Broker 
after rebooting the Oracle database server:

1 Log on as root.

cd openlink-home/openlink_server/aix4_power

2 Copy the script rc.OpenLinkBroker script to the /etc directory. 

cp rc.OpenLinkBroker /etc/openlinkbroker

3 Edit the script to change the value of BIN_DIR to

openlink-home/openlink_server/aix4_power/bin

4 Make the script executable: 

chmod +x /etc/openlinkbroker

5 Edit /etc/inittab and add the line:

openlinkbroker : 2 : wait : /etc/openlinkbroker

>ln -s openlink-home/rc.openlinkbroker rc.openlinkbroker

Automating Startup on Reboot for an Oracle Database Server on 
Red Hat Linux

The following instructions assume that your UNIX installation uses the typical 
directories for startup and shutdown scripts. To restart the OpenLink Request Broker 
after rebooting the Oracle database server:
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1 Log on as root.

cd openlink-home/openlink_server/rhat_86

2 Copy the script rc.OpenLinkBroker script to the /etc/init.d directory. 

cp rc.OpenLinkBroker /etc/init.d/openlinkbroker

3 Edit the script to change the value of BIN_DIR to

openlink-home/openlink_server/rhat_x86/bin

4 Make the script executable: 

chmod +x /etc/init.d/openlinkbroker

5 Create symbolic links for startup and shutdown. Note that the example uses 98 for 
startup and 02 for shutdown. You may need to use different numbers so that the 
startup script is invoked after any Oracle and NFS startup scripts.

>ln -s /etc/init.d/openlinkbroker /etc/rc2.d/S98openlinkbroker

>ln -s /etc/init.d/openlinkbroker /etc/rc2.d/K02openlinkbroker

Customizing the Client Host Environment

If this is a first-time installation on your client host, you may want to customize to your 
environment to make it easier to use ClearQuest. 

Modifying Your Search Paths

Access to ClearQuest programs and online documentation depends on certain 
environment variable settings. The most reliable way to establish these settings is to 
edit your shell startup script.

Note:  We recommend that C shell users avoid placing ClearQuest settings in the file 
.login, which is executed only by login shells.

Shell program Startup script in root directory 

C shell .cshrc 

Bourne shell .profile 

Korn shell .profile 
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Sourcing the Setup File

To start ClearQuest, each native client must source a configuration file to modify 
pathnames and setup the CQ_HELP_BROWSER environment variable for displaying 
ClearQuest Help.

Use the source command to set up the ClearQuest environment:

■ For csh, tcsh, and other csh-compatible shells:

source cquest-home-dir/cq_setup.csh 

■ For sh, ksh, bash and other Bourne-compatible shells:

. cquest-home-dir/cq_setup.sh 

Note: If you are accessing a DB2 database, you must set the DBINSTANCE. To set the 
DBINSTANCE:

setenv DB2INSTANCE DB2-client-DB2INSTANCE-name

Setting the TZ Environment Variable on Red Hat Linux

The TZ environment variable is used by the ClearQuest native client to format the 
display of date and time information. On Red Hat Linux, you must ensure that the 
value is set to your current timezone. 

For csh, tcsh, and other csh-compatible shells:

setenv TZ timezone

For sh, ksh, bash and other Bourne-compatible shells:

set TZ=timezone;export TZ

Note: On Red Hat Linux, timezone values can be found in /usr/share/zoneinfo.

The ClearQuest startup script checks for the existence of TZ each time it is run. To make 
the this setting permanent, update your .cshrc (or .profile) login files by adding the 
appropriate command as listed previously.

Logging In to the Client

After sourcing the setup file, start the native client:

1 Change to this directory:

cd cquest-home-dir/arch/bin

2 Type ./clearquest &.

3 If the ClearQuest database registry directory entered at the end of the client 
installation contains existing database connection records, proceed to Step 5.
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If the ClearQuest database registry directory entered at the end of the client 
installation does not contain existing database connection records, the Register 
Database dialog box opens.

In the Register Database dialog box, complete the required information that your 
ClearQuest administrator has given you to connect to the schema repository. 

Parameter SQL Server Oracle DB2

Vendor SQLSERVER ORACLE DB2

Server Host name Host name Node name entered 
when cataloging 
the node (See 
Configuring a 
Database Alias to 
Connect Native 
Clients to a DB2 
Database on 
page 71.)

Database Schema repository 
database name

Not required Database alias 
catalogued for the 
DB2 database

SID Not required Instance ID for the 
Oracle database 
server. This is 
case-sensitive.

Not required

User Name Database login user 
name

Database login user 
name

Database login user 
name

Password Database login 
password

Database login 
password

Database login 
password

Connect Options Not required HOST=hostname

SID= sid

SERVER_VER=8.1

CLIENT_VER=8.1

LOB_TYPE=LONG 
or CLOB

Not required

Databases Dir ClearQuest database 
registry directory

ClearQuest database 
registry directory

ClearQuest database 
registry directory
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4 After the database information is complete, click Apply. Status information appears 
in the Output box. If the connection to the database is successful, click Close. 
Otherwise, correct the values and click Apply.

5 In the Rational ClearQuest Login dialog box, type your ClearQuest user name and 
password in the User Name and Password boxes. Select an available ClearQuest 
database from the Database box.

The native client opens the database.

Recommended Postinstallation for the Native Client

After you install ClearQuest, perform the following recommended tasks.

Configuring the Native Client to Send E-Mail Notification

If a default e-mail address was specified when you created the release area, the native 
client has e-mail notification for a default e-mail address. 

A native client user can also enable e-mail notification after installation. This may be 
necessary if a default address was not defined or to change the default e-mail address. 
To do so:

1 Type clearquest at a UNIX shell prompt.

2 Click View > E-mail Options.

3 In the E-mail Setup dialog box, select the Enable E-mail Notification option.

4 In the Your E-Mail Address box, type the e-mail address from which you will send 
notification when you modify a ClearQuest record. For example, this can be your 
e-mail address or that of a group to which you belong. The e-mail address must be 
a valid RFC-822 address. For additional information, ask your ClearQuest or 
network administrator.

5 Click OK to save your changes.

Configuring the Native Client to Receive E-Mail Notification

To configure your native client to receive e-mail notification, edit your user profile as 
follows:

1 Click View > Change User Profile. The User Profile dialog box opens.

2 Type your e-mail address in the E-Mail box.

3 Click OK to save your changes.
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Subscribing to the ClearQuest User Group

After installing ClearQuest, you may join the ClearQuest User Group. The ClearQuest 
User Group is an e-mail forum where you can share your experiences, pose questions, 
or obtain useful information from other ClearQuest users. To subscribe to the group, 
visit the Rational Developer Network Web site at http://www.rational.net/. Your e-mail 
address will not be given out to anyone.

Recommended Postinstallation Tasks for the Network 
Install

After a native client is installed (using install_release) on a network host, other UNIX 
hosts, with compatible architectures, can run ClearQuest remotely on that network 
host. To run ClearQuest remotely, you must perform the following:

■ Export the installation directory on the network host

■ Log in to the network resource, source the setup file from the remote UNIX host, 
and run ClearQuest

Exporting the Installation Directory on the Network Host

Before sourcing the setup file from a remote UNIX host, you must export /opt on the 
network host where install_release was executed. Make sure that the exported 
directory /opt on the network host is accessible to all remote UNIX hosts that will run 
ClearQuest.

Logging In to the Network Resource to Run ClearQuest

To start the native client on the remote UNIX host:

1 login to the remote UNIX host.

2 Use the source command to set up the ClearQuest environment:

❑ For csh, tcsh, and other csh-compatible shells do this:

source /net/network-hostname-where-cq-is-installed/cquest-home-dir/cq_setup.csh 

❑ For sh, ksh, bash and other Bourne-compatible shells do this:

. /net/network-hostname-where-cq-is-installed/cquest-home-dir/cq_setup.sh 

3 setenv DISPLAY remote-UNIX-hostname:0.0

4 Type ./clearquest &.
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5 In the Rational ClearQuest Login dialog box, type your ClearQuest user name and 
password in the User Name and Password boxes. Select an available ClearQuest 
database from the Database list.

The native client running on the remote UNIX host displays and opens the 
database.

Note: When accessing ClearQuest from a remote UNIX host, to add database 
connections for a DB2 database by using the Add Dbset option in the Rational 
ClearQuest Login dialog box, you must set the DBINSTANCE environment variable 
on the remote UNIX host. DBINSTANCE must be set to the same value it has on the 
host on which the native client and a DB2 client are installed. To set DBINSTANCE:

setenv DB2INSTANCE DB2-client-DB2INSTANCE-name

Recommended Postinstallation for the Web Client

Follow the instructions in the Installation Guide for Rational Server Products to 
configure ClearQuest Web on an IIS Web server. When you provide the Web client 
users with a URL, the Web client must be configured for

■ Internet Explorer or Netscape browser support

■ E-mail notification

Configuring Internet Explorer

To configure Internet Explorer:

1 Start Internet Explorer on the Web user’s desktop.

2 On the browser toolbar, click Tools > Internet Options.

3 On the Security tab, click Custom Level.

a For ActiveX controls and plug-ins, click Enable for the following options:

❑ Download signed ActiveX controls

❑ Run ActiveX controls and plug-ins (required only for the ClearQuest Advanced 
Query Editor feature)

❑ Script ActiveX controls marked safe for scripting

b For Microsoft VM, enable Java permissions by clicking any of the following 
conditions:

❑ Custom 
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❑ High Safety 

❑ Medium Safety 

❑ Low Safety

4 On the Privacy tab, click Advanced.

5 Click Override automatic cookie handling and then click Always allow session 
cookies.

Configuring the Netscape Browser

To configure Netscape:

1 Start Netscape on the Web user’s desktop.

2 On the browser toolbar, click Edit > Preferences.

3 For Netscape 4.x, expand the Advanced node in the left pane tree and verify that 
the following options as a minimum are enabled:

❑ Enable Java

❑ Enable JavaScript

❑ Accept only cookies that get sent back to original server
Or
Accept all cookies

For Netscape 7:

❑ Expand the Advanced node in the left pane tree and verify that the Enable Java 
option is enabled. 

❑ Under the Advanced node, click Scripts & Plugins and verify that the Enable 
JavaScript option for Navigator is enabled. 

❑ Expand the Privacy & Security node in the left pane tree and click Cookies. Verify 
that either of these options are enabled: Enable cookies for the originating web 
site only or Enable all cookies. 

4 Then click Advanced > Cache.

5 Set Document in cache is compared to document on network to Every time.

6 Click OK. 

Configuring the Mozilla Browser

To configure Mozilla:
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1 Start Mozilla on the Web user’s desktop.

2 On the browser toolbar, click Edit > Preferences.

3 For Mozilla, expand the Advanced node in the left pane tree to verify that the 
Enable Java option is enabled. At a minimum, the following options must also be 
enabled:

❑ Under the Advanced node, click Scripts & Plugins and verify that the Enable 
JavaScript option for Navigator is enabled. 

❑ Expand the Privacy & Security node in the left pane tree and click Cookies. Verify 
that either of these options are enabled: Enable cookies for the originating web 
site only or Enable all cookies. 

4 Then click Advanced > Cache.

5 Set Document in cache is compared to document on network to Every time.

6 Click OK. 

Configuring the Web Client to Receive E-Mail Notification

To configure your Web client to receive e-mail notification:

1 Click Operations > Change User Profile. The User Profile page appears.

2 Type your e-mail address in the E-Mail box.

3 Click Commit to save your changes.

Configuring ClearQuest MultiSite

For information about configuring ClearQuest MultiSite, see the Administrator’s Guide 
for Rational ClearQuest MultiSite.
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7Upgrading ClearQuest
This chapter describes how to upgrade your Rational ClearQuest schemas and 
databases created with a previous installation.

This chapter covers the following topics:

■ Understanding the Upgrade Process

■ Upgrading ClearQuest Packages

■ Applying Schema Changes to User Databases

■ Upgrading Feature Levels

■ Some Helpful Utilities
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Understanding the Upgrade Process

In some cases, you can upgrade directly from your starting version; in other cases, you 
need to upgrade to an intermediate version before you can upgrade to the current 
version. Review the following conditions for applicability to your ClearQuest 
administrator host and client host.

ClearQuest maintains backward compatibility, which makes it possible to install the 
new release incrementally. For example, if you upgrade some of your client hosts, these 
new clients can communicate with the databases created with a previous release. But 
to use different versions of ClearQuest in a network environment, all of the following 
conditions must be true:

■ You are running ClearQuest alone or integrations with Rational ClearCase only.

■ If you have ClearQuest clients 2001 or earlier in your network environment, you 
plan to keep your database at its current feature level. 

■ You are not running in a Rational ClearQuest MultiSite environment.

To upgrade ClearQuest, you perform upgrade tasks on three types of host:

Version installed Upgrade procedure

Rational ClearQuest 2002 or 2001A Follow the procedures in this chapter.

Rational ClearQuest 2001 or 2000 1. Upgrade to version 2001A, as described 
in “Upgrading ClearQuest” in the 2001A 
edition of Installing Rational ClearQuest.
2. Upgrade from version 2001A to the 
current version by following the 
procedures in this chapter.

Rational ClearQuest 2.0, 1.1, or 1.0 1. Upgrade to version 2000; contact 
Rational Customer Support for more 
information.
2. Upgrade from version 2000 to version 
2001A, as described in “Upgrading 
ClearQuest” in the 2001A edition of 
Installing Rational ClearQuest.
3. Upgrade from version 2001A to the 
current version by following the 
procedures in this chapter.

A Rational point product, any version Contact Rational Customer Support for 
more information.
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■ Database server host

■ Administrator host

■ Client host

The procedures in this chapter are for non-MultiSite environment. To upgrade from a 
ClearQuest MultiSite environment, read about synchronizing replicas in the 
Administrator’s Guide for Rational ClearQuest MultiSite.

Upgrading the Database Server Host

This release adds support for newer versions of some vendor databases and drops 
support for older versions. This section discusses the upgrade issues related to 
database support changes.

Note: After you upgrade to a new version of a vendor database, do not use vendor 
database tools to move your schema repository and user databases. Instead, on your 
administrator host, use the ClearQuest Maintenance Tool to migrate your schema 
repository to use the new database. Then use ClearQuest Designer to move previous 
user databases to the new location. 

Character Set Support

ClearQuest now has a feature, data code pages, which restricts ClearQuest databases 
to accept data in one character set only. 

In a UNIX environment, you must set your data code page value to ASCII. If the 
character set of your current vendor database is not equivalent to the ClearQuest data 
code page value, in this case ASCII, you must change this setting to ASCII before you 
set the ClearQuest data code page value. The following table lists the ASCII character 
sets for Oracle, SQL Server, and DB2 databases.

For instructions on determining and changing the character set support for your 
database, see Rational Solution 167217701. This solution is accessible from the Rational 
Support Web site at http://www.ibm.com/software/rational/support/.

ClearQuest data 
code page value

Oracle SQL Server DB2

20127 (ASCII) US7ASCII SQL_Latin1_General
_CP437

ASCCSID
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Oracle CLOB Support

This release supports a new Oracle data type called CLOB. If you are running mixed 
versions of ClearQuest, continue to use LONG until your entire site has been upgraded 
to version 2003.06.00. At that point, we recommend that you refer to the Release Notes 
for guidelines when specifying either CLOB or LONG for new databases.

OpenLink Broker 4.0

If you are upgrading from ClearQuest version 2001A and have previously installed 
OpenLink Broker 3.2 on your database server, you must install OpenLink Broker 4.0, 
which is included with this release.

When using Oracle 8.1.6 or 8.1.7 with Solaris, you must update the OpenLink Broker 
driver after installing OpenLink Broker. For instructions about updating OpenLink 
Broker, see Chapter 6, Postinstallation and Administration.

Other Database Upgrade Requirements

You can always switch to a different database vendor. The following requirements 
assume that you will continue to use the same vendor database:

■ If you are running Oracle server 8.0.5, upgrade to Oracle 8.1.6 or 8.1.7. On a 
Windows host, upgrade the Oracle client software to 8.1.6 or 8.1.7. 

To use interMediaText support for multiline searches, you must set up the 
corresponding version of interMediaText (8.1.6 or 8.1.7) during the Oracle server 
installation:

a Move your existing schema repositories and user databases to use the new 
Oracle version. On your ClearQuest administrator host, run the ClearQuest 
installutil utility with options convertschemarepo and convertuserdb. For 
detailed usage of these options see Creating Database Copies on page 102. 

b Follow the instructions in Chapter 2, Configuring Vendor Databases, to enable 
multiline search on the new Oracle databases.

Note: If you are using Oracle 8.1.7, you must upgrade Oracle 8.1.7 to release 
8.1.7.3 for Solaris or release 8.1.7.4 for HP-UX, AIX and Red Hat Linux. 

■ If you are running Microsoft SQL Server 6.5, 7.0, or 2000 Service Pack 0, 1, upgrade 
to 7.0 Service Pack 4 or 2000 Service Pack 2 or 3.

■ If you are running IBM DB2 Universal Database 7.1, upgrade to DB2 7.2 Fix Pack 8 
or DB2 8.1. 

See the vendor documentation for general upgrade instructions.
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Upgrading the Administrator Host

The ClearQuest administrator host must be a Windows host; the Administrator Tools 
are not available on UNIX.

1 Install ClearQuest. You must uninstall previous versions before installing the new 
release. For prerequisites and installation instructions, see the Installation Guide for 
Rational Server Products. If you want to connect to the schema repositories you set 
up in the previous release, back up the connection profiles before you install the 
new release.

2 Installing ClearQuest may reset the connection to the ClearQuest database. To 
reconnect, see Connecting to a Schema Repository on page 92.

3 Set the data code page value of your schema repositories. See Setting the ClearQuest 
Data Code Page Value on page 93.

4 Upgrade ClearQuest packages, test your databases, and check in the changes to 
the schema repository. 

5 Apply schema changes to your user databases. See Applying Schema Changes to 
User Databases on page 95. 

We recommend that you perform Step 4 and Step 5 during the same logon session.

6 Optionally, upgrade ClearQuest feature levels if you want to enable new features. 
See Upgrading Feature Levels on page 96.

Upgrading the Client Host

1 Install ClearQuest. In previous releases, the rs_install program was used to install 
ClearQuest. Starting with this release, the install_release program handles 
installation on UNIX. 

Running install_release does not remove previous versions of ClearQuest. To 
deinstall previous versions on your host, you must run rs_install. Read Chapter 1 
to see whether you have met the prerequisites. Then create a network release area 
(Usually a ClearQuest administrator does this), as described in Chapter 4, and 
install the latest release, as described in Chapter 5. If you want to connect to the 
schema repositories you set up in the previous release, back up the connection 
profiles before you deinstall the old release.

You may install ClearQuest client on each client host. Alternatively, you can install 
ClearQuest client on a network host and export the installation directory so that 
other UNIX hosts, with compatible architectures, can run ClearQuest remotely on 
that network host. For more information, see the network install section in 
Chapter 6.
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2 Installing ClearQuest may reset the connection to the ClearQuest database. To 
reconnect to your ClearQuest database, see Connecting to a Schema Repository on 
page 92.

Connecting to a Schema Repository 

After you have installed the latest ClearQuest release, you may have to reconnect to 
your schema repository.

On a Windows Administrator Host

1 Start the ClearQuest Maintenance Tool.

Click Start > Programs > Rational Software > Rational ClearQuest > Rational 
ClearQuest Maintenance Tool. 

2 Click Connection > New.

3 In the right panel, enter your database properties; in the left panel, give your 
connection a new name. 

If you saved a profile that includes all the information you need before you install 
the latest version, you can do the following:

a Click File > Import Profile.

b Enter the path and file name in the File Name text field. If you have previously 
configured the default connection profile using Site Prep, the default location of 
the profile should be prepopulated in the File Name text field. Click Next. 

Note: A profile file has an .ini extension, for example, dev_profile.ini.

c Check the databases you want to load into ClearQuest.

4 Click Finish. Your database will be connected to ClearQuest and be displayed in 
the left panel tree node.

On a UNIX Client Host

■ To connect to the schema repositories that you set up in the previous release, move 
the connection profiles that you preserved to the default database directory in 
cquest-home-dir/CQDB_rgys/cqdb_registry/2003.06.00 or to a directory you designated 
during the installation.

■ To update an existing connection or establish a new one, you can use the Add 
Dbset dialog box. To open the dialog box, from the ClearQuest Login dialog box, 
click the button with three dots and select Add Dbset.
92 Installation Guide



 

Alternatively, you can run the cqreg add_dbset command to add a connection. For 
information about this command, see the Administrator’s Guide for Rational 
ClearQuest.

Setting the ClearQuest Data Code Page Value

This release has a setting called the “ClearQuest data code page” that is specified for 
each schema repository. All user databases associated with a schema repository use the 
same ClearQuest data code page value. This value enforces a single code page for the 
database set and prevents characters not in the selected code page from entering the 
databases. If you have UNIX clients in your network environment, you must set your 
data code page value to ASCII. 

Follow these general instructions to set the ClearQuest data code page. For more 
information about performing the specific steps, read about ClearQuest and code 
pages in the Administrator’s Guide for Rational ClearQuest.

1 Databases created with previous versions of ClearQuest may contain non-ASCII 
data. When you set the ClearQuest data code page, the data in your databases is 
not converted to ASCII characters. You must follow the vendor documentation to 
convert the data in your databasesASCII.

2 Make sure that no ClearQuest clients are connected to the schema repository or 
user databases. 

3 Backup the schema repository and all user databases.

4 Set the ClearQuest data code page for an existing schema repository or user 
database. Run the installutil setdbcodepagetoascii command. 

If you have clients running versions of ClearQuest prior to v2003.06.00, you must also 
perform Step 5.

5 Apply the CharacterSetValidation package to all ClearQuest schemas, and copy 
the ClearQuest data code page value to all associated user databases.

Upgrading ClearQuest Packages

Each ClearQuest package implements a ClearQuest integration (for example, with 
Rational RequisitePro) or a feature (for example, e-mail rules).

To upgrade packages:

1 For each schema, apply package upgrades.

2 Test your changes and check in the changes to the schema repository.
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3 Apply schema changes to your user databases.

This chapter explains how to upgrade packages, but it does not provide information 
about the features that each package implements or the dependencies among 
packages. For more information about ClearQuest packages, see the Administrator’s 
Guide for Rational ClearQuest. For a list of packages upgraded with this release, see the 
the Release Notes for Rational ClearQuest.

Applying Package Upgrades

To upgrade ClearQuest packages:

1 Start the ClearQuest Designer: 

a Click Start > Programs > Rational Software > Rational ClearQuest > Rational 
ClearQuest Designer.

b Log on with Super User or Designer privileges.

c If the data code page message appears, place a check mark next to this step to 
remind yourself later to take action. Click OK.

d If the Open Schema Wizard appears, click Cancel to close it. (To control whether 
the wizard appears, clear or set the Show this wizard at startup check box.) 

2 Create a test database against the schema that you want to upgrade. For 
instructions, see the section about creating a test database in the Administrator’s 
Guide for Rational ClearQuest.

3 Start the Upgrade Installed Packages Wizard. Click Package > Upgrade Installed 
Packages.

4 On the Select a schema to upgrade page, the wizard lists the available schemas. 
Select the schema you want to upgrade. Click Next.

The Upgrade Installed Packages Wizard checks out the schema, analyzes which 
packages need upgrading, and determines whether those packages have any 
prerequisites packages.

5 On the Status page, note the list of packages that need upgrading. 

Note: You may want to copy this list to a text file for later reference; some packages 
require additional work, as described in Step 8.

The wizard applies packages to the schema in the correct order. 

6 When the wizard finishes, read the status message to verify that the package 
upgrade was successful. In the open schema, inspect the changes and possibly 
perform additional tasks. Complete the work for this schema before upgrading 
other schemas.
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7 Validate the changes you made; click File > Test Work. 

8 If you are applying certain packages, perform these additional steps:

9 Check in the schema; on the Designer menu, click File > Check In. 

10 To upgrade additional schemas, repeat Step 3 to Step 9.

Changing the Data Code Page Value

When you applied package upgrades, you may have seen a warning about the data 
code page value (see Step c  on page 94). The data code page value refers to the legal 
character set that you can use to enter data into a ClearQuest database. In a UNIX 
environment, you are restricted to using ASCII characters only. 

Applying Schema Changes to User Databases

This section explains how to apply schema changes to your user databases. Perform 
these steps now. In general, you should always apply schema changes after you make 
changes in the ClearQuest Designer, such as applying packages, to push changes to the 
user databases.

Applying schema changes takes a few minutes for each user database. 

Warning: After you apply schema changes, you cannot reverse or undo the action. 
Always back up your databases before starting this procedure. For backup procedures, 
see your database vendor documentation.

To apply schema changes:

Package to apply Procedure

RequisitePro 
RequisitePro Upgrade

See the Upgrade Guide for Rational Suite.

E-mail After applying schema changes to the user databases 
( on page 95), verify that e-mail notification for each of 
your client users is enabled. For each type of client 
user (Windows, UNIX, and Web), see the appropriate 
section (The section titles start with “Enabling e-mail 
notification for...”)
ClearQuest reminds you to perform this task after you 
apply the schema change.
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1 Log in to ClearQuest Designer with Super User or Designer privileges.

2 If the Open Schema Wizard appears, click Cancel. 

3 Select Database > Upgrade Database.

A message warns that this action cannot be reversed, recommends that you back 
up your databases before proceeding, and asks for confirmation to continue. If you 
have backed up your databases, click Yes.

4 Select the user database from the list presented in the Upgrade Database Wizard. 
Click Next.

5 Select the schema version from the list. If your most recent version is not on this 
list, it probably has not been checked in. If so, cancel this wizard, open the schema 
from the File menu and check it in. Then restart this process from Step 3.

6 Click Finish. When the user database upgrade completes, you see a message that 
the database has been upgraded successfully.

Upgrading Feature Levels

This section describes how to upgrade ClearQuest feature levels. These steps are 
optional, as follows: 

■ Perform the upgrade if you want to enable the latest features in ClearQuest. In 
Version 2003, these new features are Rational ClearQuest MultiSite (introduced in 
2001A.04.20) and an improved security model (introduced in Version 2001A).

■ Do not perform the upgrade if you do not want to enable these new features. Also, 
if you have already upgraded to the ClearQuest feature level introduced in Version 
2001A, do not perform the upgrade again.

Upgrading ClearQuest feature levels can take several hours. The upgrade changes the 
schema repository and all its associated user databases. Typically, new tables are added 
to all databases, and new columns may be added to existing tables.

Before you perform the upgrade, verify that all ClearQuest users have installed the 
ClearQuest release that supports the new feature level.

The following table lists the feature levels supported at each ClearQuest release.

ClearQuest version Supported feature levels

1.0 1

1.1 and 1.1 Service Packs 2
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To determine the current feature level of your databases, check the value for the feature 
level in the following tables:

■ For a schema repository, open the master_global table and refer to the feature level 
field.

■ For a user database, open the db_global table and refer to the feature level field.

Note: If you are upgrading Oracle databases, you can accelerate the upgrade process 
significantly by running the Oracle ANALYZE command. For instructions, see the 
Oracle documentation. 

Overview of Feature Level Upgrade Process

As part of upgrading ClearQuest feature levels, we strongly recommend that you 
perform the upgrade first on a test system, and then perform it again on production 
databases. At a high level, the process is as follows:

1 Verify your environment.

2 Create a test bed based on production databases.

3 Upgrade the test bed and validate that the upgrade was successful.

4 Create new databases for the production system.

5 Upgrade the production databases and validate that the upgrade was successful.

Verifying Your Environment

Before you start the upgrade, be aware that it can fail under certain conditions. The 
following table describes these conditions and how to resolve them.

2.0 3

2000 3

2001 3

2001A 3, 5

2002 3, 5

2003 3, 5

ClearQuest version Supported feature levels
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Creating a Test Bed

A test bed is a safe, nonproduction area where you can test your changes. We 
recommend that you perform the upgrade on the test bed first before you upgrade 
your production databases. The following steps describe how to create a test bed based 
on your production databases:

1 Create a backup copy of your ClearQuest schema repository and user databases.

2 Create new, empty vendor databases for each schema repository and user 
database, as described in Chapter 2. Create the new databases in a new test 
directory or on a test server. In this section, these new databases are referred to as 
the test bed.

Note: Create empty databases only. Do not use your vendor database tools to move 
or copy the data. ClearQuest updates the data structure and moves it into the new 
databases as part of the upgrade process.

3 Shut down your Web server, stop any scheduled ClearQuest MultiSite 
synchronization jobs, and ensure that all users have disconnected from ClearQuest 
by using one of these techniques:

❑ Some high-end databases give the administrator a tool for logging users off the 
database. If your vendor database has such a tool, use it.

❑ Check the Task Manager Process List of each client and server computer. If one 
of these processes is running, use the Task Manager to end clearquest.exe, 
cqdesign.exe, or any cqintsvr*.exe process.

4 Copy your existing production schema repository and user databases to the test 
bed and establish a connection to ClearQuest. Use the ClearQuest installutil utility 
with options convertschemarepo and convertuserdb. For more information about 
these options, see Creating Database Copies on page 102.

Condition Solution

You currently have a ClearQuest schema 
checked out.

Check in your ClearQuest schema.

Your ClearQuest database is locked. Unlock your database. For more 
information, see Unlocking Databases on 
page 101.

You have customized your schema to 
include Record Types or fields that have a 
ratl_  prefix.

Contact Rational Customer Support. They 
will explain how to correct this condition.
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5 The convert options for installutil also locks the production database. To allow 
users to continue using the production database while you upgrade the test bed, 
unlock the production database. See Unlocking Databases on page 101.

6 For each database in the test bed, create a new empty vendor database. These will 
be the databases that you upgrade to. This section refers to these new databases as 
the test upgrade set.

Upgrading the Test Bed

In this section, you upgrade the test bed and verify that the upgrade was successful. To 
upgrade the test bed:

1 Start the ClearQuest Maintenance Tool. 

2 In the Existing Connections area, select the connection you need to upgrade.

3 Click Schema Repository > Upgrade > Selected Connection.

4 At the prompt to upgrade user databases, click Yes.

5 Log in with Super User privileges.

6 Enter the properties of the schema repository to upgrade to (the empty database 
you created in the test upgrade set); then click Next.

7 Enter the properties for the first user database you are upgrading to (the empty 
databases you created in the test upgrade set). Click Next. Repeat until you have 
associated all the user databases. Click Finish.

ClearQuest upgrades your schema repository and user databases, and notifies you 
when the process is complete. It records all actions in a text file in the \Temp 
directory.

8 Verify that the upgrade process completed successfully:

a When the process completes, read the status message carefully to verify that it 
completed successfully (Scroll to the end of the message). Click Done.

b Test the application. Enter a few test records of each record type and move them 
through the entire state model to be sure the upgrade is working correctly.

Creating Production Databases

After you verify that the test upgrade is successful, you can upgrade your production 
databases. The procedure is nearly identical to that for upgrading the test databases. 

To upgrade production databases:
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1 Create empty vendor databases for each schema repository and user database, as 
described in Chapter 2. Create the new databases on the production server. These 
new databases are the production upgrade set.

Note: Create empty databases only. Do not use your vendor database tools to move 
or copy the data. ClearQuest updates the data structure and moves it into the new 
databases as part of the upgrade process.

2 Notify users to log off from ClearQuest. Shut down your Web server, and stop any 
ClearQuest MultiSite synchronization jobs.

Upgrading the Production Databases

To upgrade from your original production databases to the production upgrade set:

1 Start the ClearQuest Maintenance Tool.

2 In the Existing Connections area, select the connection you need to upgrade. 

3 Click Schema Repository > Upgrade > Selected Connection.

4 At the prompt to upgrade user databases, click Yes to continue.

5 Log in with Super User privileges.

6 Enter the properties of the schema repository to upgrade to (the empty database 
you created in the production upgrade set); then click Next.

7 Enter the properties for the first user database that you are upgrading to (the 
empty databases you created in the production upgrade set). Click Next. Repeat 
until you have associated all the user databases. Click Finish.

ClearQuest upgrades your schema repository and user databases, and notifies you 
when the process is complete. It records all actions in a text file in the \Temp 
directory.

8 Verify that the upgrade process completed successfully:

a When the process completes, read the status message carefully to verify that it 
completed successfully (scroll to the end of the message). Click Done.

b Test the application. Enter a few test records of each record type and move them 
through the entire state model to be sure the upgrade is working correctly.

9 Perform additional steps after the upgrade completed successfully:

a To prevent users from using the original production databases, either keep 
them locked or remove them.

b Optionally, discard the test bed and test upgrade set.
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Some Helpful Utilities

This section lists four subcommands for the installutil utility. All parameters are 
required unless stated otherwise in the Description table and must be entered in the 
order specified in the syntax.

Unlocking Databases 

When you create database copies using installutil, the convertschemarepo 
subcommand locks your production database before copying it to your test bed. To 
allow users to continue using your original databases while you test the upgrade, 
unlock the database.

Note: After you complete the final upgrade, do not unlock your original databases. 
Keeping the original databases locked prevents users from accessing the wrong 
databases.

1 On the ClearQuest administrator host, open a command line window (a DOS 
prompt).

2 To unlock the schema repository, enter the following command for your vendor 
database:

installutil unlockschemarepo db_vendor server database dbo_login dbo_password 
connect_options

where:

Parameter MS SQL Oracle DB2

db_vendor SQL_SERVER ORACLE DB2

server Host name SQL*Net alias Not required

database Schema repository 
database name

Schema repository 
database name

Schema repository 
database alias

dbo_login Database owner 
user name

Database owner 
user name

Database owner 
user name

dbo_password Database owner 
password

Database owner 
password

Database owner 
password
Chapter 7 - Upgrading ClearQuest 101



 

3 To unlock user databases, repeat Step 2 with the following exceptions:

❑ Use the unlockuserdb subcommand instead of unlockschemarepo.

❑ Point to the vendor database that contains the original user database, not the 
schema repository.

Creating Database Copies

To copy your schema repository and create a sample database for testing the upgrade 
process, run the installutil utility with the convertschemarepo subcommand on your 
administrator host. This subcommand does the following:

■ Copies the original database to a new database.

■ Connects ClearQuest to the database copy.

■ Locks the original database.

Note: Before executing this command, back up your databases and create new 
databases using your database vendor tools.

To create a copy of your databases to test the upgrade process offline:

1 Create new test databases. See Creating a Test Bed on page 98.

2 Use installutil convertschemarepo to copy your existing schema repository and 
connect it to ClearQuest. See installutil convertuserdb on page 104 for sample input 
parameters by vendor type.

3 Use installutil convertuserdb to copy each of your existing user databases and 
connect them to ClearQuest. See installutil convertuserdb on page 104 for sample 
input parameters by vendor type.

connect_options ““ HOST=host

SID= sid

SERVER_VER=[7.0, 
8.0, 8.1]
CLIENT_VER=[7.0, 
8.0, 8.1]

““

Parameter MS SQL Oracle DB2
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installutil convertschemarepo

installutil convertschemarepo [-dbset dbset_name] cq_login cq_password to_db_vendor 
to_server to_database to_dbo_login to_dbo_password to_rw_login to_rw_password 
to_ro_login to_ro_password connect_options [tcpip,ipx,netbios,namedpipes] [host1,host2,...]

where:

Parameter Description

dbset_name The name of the existing connection.

cq_login The user login name for ClearQuest databases that you 
want to copy. The user must have Super User privileges.

cq_password The login password for the ClearQuest Super User.

to_db_vendor The new upgrade vendor database name. Available 
choices are  SQL_SERVER, ORACLE, DB2.

to_server The new upgrade database server name.

to_database The new upgrade database name.

to_dbo_login The login name of the empty database owner.

to_dbo_password The login password of the empty database owner.

to_rw_login The read/write login name for the empty database.

to_rw_password The read/write login password for the empty database.

to_ro_login The read-only login name for the empty database.

to_ro_password The read-only login password for the empty database.

connect_options This is required only for Oracle. Required parameters:
HOST=host;SID=sid; 
SERVER_VER=server_version_number; 
CLIENT_VER=client_version_number; 
LOB_TYPE=data_type

[tcpip,ipx,netbios,
namedpipes] 

These are optional parameters to specify networks.

[host1,host2,...] These are optional parameters to identify multiple host 
machines.
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installutil convertuserdb

installutil convertuserdb [-dbset dbset_name] cq_login cq_password user_dbname 
to_user_db_vendor to_user_server to_user_database to_user_dbo_login 
to_user_dbo_password to_user_rw_login to_user_rw_password connect_options 
[tcpip,ipx,netbios,namedpipes] [host1,host2,...]

where:

Parameter Description

dbset_name The name of the existing connection.

cq_login The user login name to ClearQuest databases that you 
want to copy. The user must have Super User privileges.

cq_password The login password for the ClearQuest Super User.

user_dbname The name of the user database that you want to convert.

to_user_db_vendor The new upgrade user vendor database name. Available 
choices are SQL_SERVER, ORACLE, DB2.

to_user_server The new upgrade user database server name.

to_user_database The new upgrade user database name.

to_user_dbo_login The login name of the owner of the empty user database.

to_user_dbo_password The login password of the owner of the empty user 
database.

to_user_rw_login The read/write login name for the empty user database.

to_user_rw_password The read/write login password for the empty user 
database.

connect_options This is required only for Oracle. Required parameters:
HOST=host;SID=sid; 
SERVER_VER=server_version_number; 
CLIENT_VER=client_version_number; 
LOB_TYPE=data_type

[tcpip,ipx,netbios,
namedpipes] 

These are optional parameters to specify networks.

[host1,host2,...] These are optional parameters to identify multiple host 
machines.
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Sample Data by Vendor Type

The following table provides example command-line input parameters for each 
database type.

Parameter MS SQL Oracle DB2

db_vendor SQL_SERVER ORACLE DB2

server Host name SQL*Net alias Not required

database Schema repository or 
user database name

Schema repository or 
user database name

Schema repository 
or user database 
alias

dbo_login Database owner user 
name

Database owner user 
name

Database owner 
user name

dbo_password Database owner 
password

Database owner 
password

Database owner 
password

rw_login Read/write owner 
user name

Read/write owner 
user name

Database owner 
user name

rw_password Read/write owner 
password

Read/write owner 
password

Database owner 
password

ro_login Read-only owner 
user name

Read-only owner 
user name

Database owner 
user name

ro_password Read-only owner 
password

Read-only owner 
password

Database owner 
password

connect_options ““ HOST=host

SID= sid

SERVER_VER=8.1
CLIENT_VER=8.1
LOB_TYPE=CLOB

““
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